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INTRODUCTION 
 
 
The purpose of this manual is to provide a complete guide to ILO Library practice in 
cataloguing in Labordoc, the bibliographic database of the ILO, produced by the ILO Bureau 
of Library and Information Services (INFORM) with the participation of other ILO 
documentation centres in Geneva, and by libraries and documentation centres in ILO offices 
around the world. 
 
Labordoc runs on Voyager, an integrated library system, and follows international 
cataloguing standards, Anglo-American Cataloguing Rules (2nd ed. 2002 rev.) and the 
MARC21 format. In some cases the rules have been adapted in order to enhance the 
information on the content of the publication, and to facilitate finding ILO publications.  
 
This manual sets out the cataloguing practices followed by the ILO Library. You will find 
here instructions for the installation and use of the Voyager cataloguing module, an 
explanation of MARC fields and cataloguing standards used in Labordoc. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
We welcome your comments or suggestions at inform@ilo.org. 
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Voyager Record Structure 

 
Voyager uses standard MARC bibliographic, authority and holdings records. The different 
types of records are linked together, with the bibliographic record at the centre of the 
relationship. 
Each type of record receives a record number (called bib id for bibliographic records). 
 
Bibliographic records contain the MARC bibliographic record information and the record 
history. 
 

  
 
 
Holdings records (also known as mfhd: MARC Format for Holdings) contain information 
about the locations where the documents are held. 
Holdings records are linked to bibliographic records to represent each copy held by the 
library. A bibliographic record has a holding record or mfhd for each particular physical or 
electronic copy.  
Each mfhd contains the location, call number, copy information (copy 1, 2, etc.) and holdings 
information for a particular copy. 
For example, click Get Holdings to receive the information for all the copies: 
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Click Retrieve to view the holdings record selected: 
 

 
 
Item records are linked to the holdings record of each copy that can be loaned and allow a 
follow-up of the loan. 
 
Authority records are optional, and are linked to the bibliographic records automatically. 
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General procedure before cataloguing 
 
Before cataloguing a document: 
 
Search for it in Labordoc
 
It is important to search for the document in Labordoc to make sure that it is not already 
catalogued (see the chapter on “Searching in Labordoc” for more information). 
 
If the document is in Labordoc, there are several possibilities: 
 
1. There is an acquisition record 
When a  purchasing order is created in the Acquisitions module the system creates 
automatically a record in the Cataloguing module, but only some fields are filled-in (title, 
publication, etc.). 
For cataloguing the document you can either complete the rest of the fields or create a new 
record from a template (see the chapter on “Original Cataloguing in Voyager”, section 1 
“Create a Record”). In the second case be sure that when you save it in the database the 
Voyager duplication detection system will replace the data in the acquisition record with the 
data you entered in the new record (see the section on detecting duplicates). For that the 
information entered in the new record has to match exactly the information entered in fields 
present in the acquisitions record. 
 
2. There is a pre-catalogued record 
Some documents are pre-catalogued with a few fields (usually the title, date of publication 
and URL) to provide rapid access to the electronic text on the Internet through the OPAC. 
The cataloguing procedures remain the same. 
 
3. There is a complete record for the document 
- If  you work in INFORM write the bib id, the callno and the copy number on the document 
and send it to the Collections Manager.  
- If  you work in a field office or in another department at Geneva follow the chapter on 
AAdding Field Offices and Documentation Center’s locations and callnos”. 
 
If the document is not in Labordoc
 
Catalogue it directly in Voyager. See the chapter on “Original Cataloguing in Voyager”. 
If you need to add a corporate author or title of a monographic series, always search the 
database for examples (see the chapter on “Searching in Labordoc”). 
 
 
Note: If the document is not in Labordoc and you work in INFORM you can search in OCLC 
(see “Copy Cataloguing Records on OCLC”) and download the OCLC record to Voyager, 
and adapt it to Labordoc style. 
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Searching in Labordoc 
 

It is important to search for examples of the document to be catalogued, for example to be 
sure of the authorised form for an access point (corporate body, series, etc.).  
Searching options: 
 
If you are searching for a specific document and you know the bib id (record number) 
 
Click on the Record menu>Retrieve by record id>Bibliographic and type the bib id 
directly. Example: 353334 
 
Using the option SEARCH 
 

Click the Search icon,  or select Record>Search. 
The search dialog box allows you to search in several ways. Below are the most relevant 
choices. 
 
Keyword tab
 
For searching the number of records indexed by an indexer in a certain month type: 
 
925a  aa and 920d  A2005 05 ?@ and 920a biblio 
 
being: 
 
- aa  are the indexer’s initials. This information is in field 925 subfield a 
- 2005 05 ? is  the date of indexation, this information is in field 920 subfield d: “2005 05” is 
the year and the month, the “?” is added so as to search over the whole month 
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- biblio is the final status of a record (after cataloguing, indexing and revision), this 
information is in field 920 subfield a.
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Non-Keyword tab 
 

 
 
Choose the option or field in which to search in the Search by menu and enter the 
information in Search for. The most common searches are: 
 
Search by Search for 
Title Document title. 

Enter title as written, omitting initial articles (a, the, le, el, etc.). 
Ex.: global alliance against forced labour (for a title starting 
with “A global…”) 

Mfhd Call Number Callno: 105A203 
Staff Name Headings Authorities. 

Enter as written. 
Ex.: ilo infocus programme on crisis response and 
reconstruction 

System Number ISN of the old database (ilb): ilb345654 
OCLC number: ocm55877924 

Cataloguing info Number of records catalogued in the indicated period by a 
cataloguer: xx 2004? 

Journal Title Serial Title. 
Enter title as written, omitting initial articles (a, the, le, el, etc.). 
Ex.: international labour review 

Bib id Bib id (record number): 375380 
ISBN ISBN (without “-”):9221167747 
Local Status Records with the indicated status. 

It is also possible to indicate a specific period: btran 2005-05? 
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Builder 
 
Allows you to design a boolean search as in the AGuided Search” option in the OPAC. 
 

 
 
- Choose among these options: 
any of these = OR 
all of these = AND 
as a phrase = “...” 
- Enter your search terms in Search for. 
- Chose the field in Search in. 
- A multiple search can be performed by adding another search with the buttons AND, OR, 
NOT. 
- Limit the search with the ALimit@ button.  
- To truncate, use question mark: globali? 
 
Some useful options for cataloguing uses: 
 
Keyword anywhere 
Search in all the fields by selecting Keyword anywhere. 
For example, useful for searching corporate names if you do not know the correct authority. 
Search on the information available in the document: 

indisco programme 
ipec 

 
Title Keyword 
Allows user to search for titles containing a particular word or group of words.  
 
Example: 

 17

- for searching : “Improving prospects for young women and men in the world of work” 
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- select all of these 
- enter prospects young women men world work in Search for 
- select Keyword anywhere in Search in 
 
- Do search 
 

 
 
 
Series keyword 
If the document belongs to a series, search in Series keyword for examples of the same 
collection: employment strategy papers. 
 
Published in (journal name) 
For searching analytic records (articles) of a serial title: international labour review. 
 
History
Displays the searches performed during the current session and allows user to edit or re-do a 
search already performed. 
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Titles button 

 
At any point in your session you may return to your previous search result window by 
clicking on the Titles button. 
 
Headings button  
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You may return to your previous authorities search result window by clicking on the 
Headings button. 
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Adding locations and callnos 
 in Field Offices and 

Documentation Centres 
 
1. Search for the document in LABORDOC. 
2. If it is found, click on New Hldgs. 
3. Click on New. 
4. Fill in the 852 field. Add your location in $b subfield (see location list on the next 

page) and the call number for the document in your own centre in $h subfield: 
 852 8  $b location $h callno 
 example: 
 852 8  $b DCE $h 98POLDEV23 
5. Save to DB. 
6. To view the location created: 
 click Get Holdgs>select the desired location >Retrieve 
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7. Close the mfhd record and the bibliographic record. 
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LOCATIONS LIST 
 
DIALOG   DCD 
Electronic documents  e-doc 
Electronic serials  e-ser 
EMPLOI   DCE 
ILL    ILL 
INFONORM   DCI 
INSTITUTE   DC2 
ISSA    DC3 
Library-Acquisitions  INFACQM 
Library-Client Services INFCS 
Library-Info Mgmt  INFCAT 
Library-Loans-Service INFLOANS 
Library-Main Collection INF 
Library-Periodicals  INFACQS 
Library-Reference  INFREF 
Library-Statistics  INFS 
Library-Systems  INFSYS 
Library-Video   INFV 
Not catalogued  NCAT 
PROGRAM   DCP 
REVIEW   REVIEW 
SECSOC   DCS 
TRAVAIL   DC1 
ILO Bangkok   RO-BKK 
ILO Brasilia   ILO-Brasil 
ILO Budapest   ILO-BUDAPE 
ILO CINTERFOR  ILO-CINTER 
ILO Lima   ILO-LIMA 
ILO London   ILO-LONDON 
ILO Paris   ILO-PARIS 
ILO Rome   ILO-ROME 
ILO Santiago   ILO-SANTIA 
ILO Buenos Aires   ILO-BUENOS   
ILO Mexico    ILO-MEXICO  
ILO Port of Spain  ILO-POSPA 
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ILO San Jose    ILO-SANJOS  
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Copy cataloguing records from OCLC 
 
1. Search for item in LABORDOC. 
 
2. If it is not found, search for item in the OCLC Connexion WorldCat: 
- Click the icon OCLC Connexion 
- Be sure that in the Tools>Options>Access the Address is proxy.ilo.org and the Port 3128, 
then OK 
 

 
 
- File>Log on 
- Authorization: 100-126-703 
- Type in your Password. 
- Search for the document: 
Cataloguing>Search>WorldCat 
Keyword/Numeric Search>Search for Enter the title, ISBN or other options and OK. 
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- When a matching record is found, check the following fields (the information in these fields 
must match the item exactly): 

Blvl (fixed field)  m,s,a 
Title    245 
Edition   250 
Imprint   260 
Physical Description  300 
Series statement  440 or 490 
 

3. Export the record: Action>Export 
(Note: if the system asks for name of the file to export enter: C:\oclcapps\passport\export.dat) 
 
4. In VOYAGER : Record>Import 
- From new file (if it is the first daily record imported). Choose file. 
- From previous file (if it is not the first daily record imported). 
 
5. Add these fields (library staff for library’s documents): 
Call number 099 9 105AXXX 
Catid  946    $a  XX1  (your initials) $d year-mm-dd 
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Adapt the record to Labordoc style (for example if necessary add entries for corporate 
authors, add 088 field, add 246 field/s, etc.)  
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Delete fields 994 and 072, 520, 650, 655 if present, and other fields not accepted by the 
validation process. 
 
Copy the indexation fields (072, 520, 650, 655, 920, 925) from the template Engl to the new 
record. 
 
Save the record. 
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Original cataloguing in Voyager 
 
 
1. Create a record. 
2. Save the record. 
3. Detecting duplicates. 
4. Authority validation. 
5. Adding the mfhd records. 
6. Delete a record. 
7. Copy descriptors process. 
8. Revising BIBLIO records (REV). 
9. Templates. 
 
 
1. Create a record 
 
New bibliographic records can be created in two ways: 
 
1- By creating records from a template: 
 
Record>New>Bibliographic>Choose the template 

There are a set of templates for cataloguing different kinds of documents: 
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ANA= Analytics, CIP= Cataloguing in Publication Data, DEFAULT= Templates given by 
Voyager and not used, GB= Governing Body Documents, IGO= International Organizations 
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Documents, ILO= ILO documents, MONO= Other monographs, SER= Serials, VIDEO= 
Videocasettes 
2 - By copying an existing record: If you have found a record similar to the one you want to 
create: 
Record>Make a copy 
In this case be sure that you enter the modifications in the ANew bib record@ and not in the 
original record that is also displayed. 
 
IN BOTH CASES, no. 1 creating a record from a template or no. 2 copying and existing 
record, you have a bibliographic record with several fields to fill in, fixed and variable fields.  
The most important data are in the variable fields (author, title, etc.) but some of the coding in 
the fixed fields also has an impact in the OPAC because it affects the search limits (year, 
language, etc.). 
 
Tabs 
 
When displaying a saved record there are three tabs: MARC, System and History: 
 
The MARC tab displays the fields to be catalogued. 
 
The System tab contains check boxes.  Sometimes the box ASuppress from OPAC@ is used 
when the record is not to appear in the OPAC. 
 
The History tab shows who has worked on the record, when the action took place and the 
kind of action taken: create, merge, update, replace, etc. 
 
Fixed fields 
 
See the Fixed Fields section for more information. Here are instructions for entering 
information: 
 
The LEADER should not be changed. 
 
Only some values in 008 have to be chosen or entered. The dates must be typed in. Codes for 
country and language can also be typed in if you know them or you can also open the list 
from the drop-down menu and click on the one you want. 
 
Variable fields 
 
See the Variable Fields section for more information. Here are instructions to enter 
information: 

Displaying several records 

Several records can be displayed at the same time. Open the records and choose in the 
Window menu. You may display two records side-by-side if the Title command is selected, 
or display several records in cascade if the Cascade command is selected. 
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F2 Pressing F2 will give a list of valid codes related to the cursor location (MARC tags, 
indicators, subfields). 
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F9 provides the subfield delimiter. 
Select a field 
 
Position the cursor in the green area before the field number and click. 
 
Copy, Cut and Paste 
 
 Select a field or a text then click Cut, Copy or Paste in the Edit menu. Alternatively, use 
Ctrl+c for copying, Ctrl+x for cutting and Ctrl+v for pasting. 
 
 
Delete a field  
 
Select the whole field and press the Delete key on your keyboard. You will be asked for 
confirmation. 
 
ADD a new variable field 
 
Use F3 to insert a line above and F4 to insert a line below the field with the cursor. 
 
Special Character Entry 
 
Select Special Character Entry from the Edit menu. 
Select the appropriate character. 
Click on the Insert box to insert the character, or on the Insert/Close box to insert the 
selected character, and then close the dialogue box. Clicking on the Close box will simply 
close the dialogue box. 
If necessary, type the character associated with the diacritic. 
 
Print a record 
 
Record>Print record 
 
 
2. Saving records 
 
A record can be saved at any point, Save to DB.  
 
If there are MARC errors, these will be listed. If you have difficulties in fixing any of these 
(sometimes they are in unusual fields not often encountered) remember that if you put your 
cursor where the error occurs and press F2, you will get a list of all the valid codes. If still in 
doubt, ask for help. 
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Once any MARC errors have been corrected, Save to DB again, and you will see an 
Authority Validation box, which tells you whether the headings and subheadings in the 
record are valid (i.e. authorized). You now have the option of looking at the authority record, 
if there is one, searching the database under the heading, or creating a new authority record. 
(See “4. Authority Validation” and the section Authority records for more information). 
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When you have finished with this box, click on Continue, and the record will then be saved 
to the database and assigned a record number (bib id). 
When you have saved the record, your user id will appear on the History tab, indicating that 
you created, merged, updated, or suppressed the record. 
 
Do not forget to create the holdings records (see section 5 “Adding the mfhd records” and the 
chapter on “Authority Records”). 
 
 
3. Detecting Duplicates 
 
When a record is saved  in the database Voyager checks for any duplicates and if detected the 
“Bibliographic Dedupe Detection” dialogue box will be displayed which lists all of the 
records that are potential duplicates according to the rules defined in the System 
Administration module: 
 

 
 
Click Retrieve to view the MARC record selected to check if it is in fact a record for the 
same document you wish to catalogue. 
If the document is not already catalogued click Add As a New Record button to add the 
record to the database as a new record. 
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If you want the catalogued record to replace one of the records in the list, make sure that only 
the target record in the list is highlighted and click the Replace/Merge using profile button. 
The new record replaces the old one with the same bib id. 
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Click Clear All to deselect all selected records in the list. 
 
Remember that every purchased document is already in the database because the system 
creates a record in the cataloguing module (with a few fields filled in) when a purchase order 
is created in the acquisitions module.  
 
Also remember that for cataloguing a purchased document you can either complete the rest of 
the fields in the existing record or create a new record from a template (see the chapter on 
“Original cataloguing in Voyager”, section 1 “Create a record”) and replace after the 
acquisition record with the new one. 
 
If you choose the second case you have to be sure that the duplication detection system will 
work replacing existing data in the acquisition record with data entered in the new record 
keeping the same bib id. For that the information entered in the new record has to match 
exactly the information entered in fields present in the acquisitions record. Before saving the 
new record retrieve the acquisition record and modify it to match exactly data entered in the 
new record created in order the duplication detection procedure works. 
 
 
4.  Authority Validation (see also Authority Records section) 
 
The process of saving a bibliographic record to the database includes the process of 
validating all headings in the record. When you save a record you can view the window 
“Authority validation”. 
 
With the bibliographic record displayed, you may also call up a list of all verified authorities. 
Select Retrieve Authorities from the Record menu.  
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In the window “Authority Validation” each heading in the bibliographic record will be 
checked for a matching authority record. 



- Procedures - 

 

There are two possibilities: 

1. The headings in the bibliographic record match established headings in authority records, 
with the message: “Heading Validated”. Click on Continue to save the record. You can also 
view the Authority record if you click on Retrieve auth. 

2. If one or several headings do not match established headings, one of the following 
messages will appear: 

(a) "Cosmetic differences" 

Correct the form of the heading in the bibliographic record to match. 

(b) “Nonexistent Heading” 

Take further steps to find the appropriate form of the heading. The Authority Validation 
report includes a Search button to check the database for other variations. Selecting a 
heading from the list and clicking on the Search button will provide a browse list. From this 
list you can view the bibliographic records, the authority records or references and use the 
correct form of the authority. 
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If the heading in the bibliographic record does not have an established heading then select 
Create auth and create an authority record for the heading (see the section “Authority 
Records”). 



- Procedures - 

When you click Create auth the system gives you a record with the authority already typed 
(field 100 or 110 or 111 or 130) and in many cases also with some tracings created (field 400 
or 410, etc.). 
 
Enter the information for the 040 field:  
040   $a ILO $c ILO 
 
Add other tracings or references that would be useful for searching the authority (acronyms, 
authority name in another language, authority name in another order, etc.). 
 
Save the record, close the record window and reclick Save to DB button in the bibliographic 
record. Now the heading is validated. 
 
Note: The Authority Validation window will also attempt to validate the subject headings 
according to the subject records respecting the ILO Theasurus. See the Labordoc Indexing 
Techniques Manual. 
 
 
5. Adding the mfhd records (see also Holdings Records section) 
 
Once the bibliographic record is saved in the database, create its mfhd record(s).  
 
Click on New Hldgs 
 
The 852 field is added automatically with the location in $b subfield (which is defined in the 
Option menu>Preferences>Holdings/Item default location, INF for the Library) and the 
call number in $h (the system takes the information entered in the 099 field of the 
bibliographic record). 
 

852 8  $b location $h callno 
 

1. Example for a physical document: 
852 8  $b INF $h 105B09321 
 
2. Example for an electronic document , enter the information and save the record: 
852 8   $b e-doc $h WWW ACCESS ONLY 
856 41 $3 Full text $u http://www.ilo.org/public/spanish/dialogue/sector/ target=new 
 
 
Then Save to DB. 
 
If there is an electronic copy and physical copy of the document create two mfhds one for 
each version and add the 856 field with the http address in the mfhd for the electronic 
version: 
 
Click on New Hldgs>New and enter: 
852 8   $b e-doc 
856 41 $3 Full text $u http://www.ilo.org/public/spanish/dialogue/sector/ 
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If an electronic document (or version) has two or more URLs, create only one mfhd with all 
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the URLs in separate 856 fields: 
852 8   $b e-doc 
856 41 $3 Full text $u http://www.eurofound.ie/working/reports/NL0502TR01/.pdf 
856 41 $3 Full text $u http://www.ilo.org/ /libdoc/igo/eurofound/2005/05eurofound2.pdf 
 
Additional mfhd records are created for every physical copy of the document. Click on New 
Hldgs>New and enter the 852 with the same information as for copy 1 in subfields b and h 
and add subfield t with the copy number: 
852 8  $b INF $h 105B09321 $t Copy 3 
N.B. At Geneva headquarters the mfhd records for each additional physical copy of the 
document or the change of location for a document (from locations INF to reference, 
statistics, etc.) are created by the Library Loans Section not by cataloguers. 
 
Do not forget to close the mfhd record/s. 
 
To view the location/s created :  

click Get Holdgs 
select the location desired 
Retrieve 
 

When a purchase order is created in the acquisitions module, the system creates a record in 
the cataloguing module with a mfhd record linked. Use the existing mfhd record for the 
location: 
- Retrieve the mfhd record. 
- Change the first indicator from 0 to 8. 
- Replace the location and add the callno. 
 
 Example: 
 852 0  $b INFACQM 
 becomes 
 852 8  $a INF $h 105A340 
 
 
 
  6. Delete a record 

Authorized staff members can delete item, holdings, bibliographic and authority records. 
Before deleting the bibliographic record you have to delete the item and holdings records (if 
they exist).  To do this retrieve the bibliographic record, then the holding, then the item and 
delete them in order of item, holdings, bibliographic.  

To delete a record (item, holdings, bibliographic or authority), retrieve the record and select 
Delete from the Record menu. 

When a bibliographic record has been created by the system after an acquisition process it 
cannot be deleted. Instead you should suppress it from the OPAC by clicking in the System 
TAB the option “Suppress from OPAC”. 
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7. Copy descriptors process 
 
The descriptors from one record to another record can be automatically copied. 
This is used, for example, when cataloguing other language versions of a document. 
 
Procedure: 
1- Catalogue the English version first (if it exists). 
2- Catalogue the other/s version/s. 
3- Delete every indexing field: 072, 520, 650, 655, 925. 
4- Fill in the field 920 with the status “copy” and the date: 

920  $a copy $d 2005-07-01 
 

5- Add the field 923 and enter the record bib id for the English version. 
923 $a 354752 
 

6- The indexing fields will be copied when the English record status changes to BIBLIO (on 
Mondays). 
 
The same procedure is used whenever we want to copy automatically descriptors from one 
record to another (2-6). 
 
 
8. Revising BIBLIO records (REV) 
 
 
If changes in the descriptor string are made to a status BIBLIO record, special process is 
made to avoid changing manually all the French and Spanish descriptors in the 65X and 9XX 
fields. 
 

a. Change the status from BIBLIO to REV in the revised record. 
b. A daily job picks up all records with the status and the necessary changes in 

the 65X and 9XX fields are done automatically. 
c. The job changes the status from REV to BIBLIO. There is no change to the 

status date. 
 

 
 
9. Templates 

There is a set of templates for cataloguing different kinds of documents as explained in 
paragraph 1 “Create a record”. 

To create a new template, select File>Template>New. Add all the necessary information in 

the template record, then save the template with the Save button and give it a name:  
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For analytics templates, give the serial callno as template name. 
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To modify a template: File>Template>Edit.  Enter the modifications and Save. 

It is possible to create new templates by editing an existing template: File>Template>Edit. 
Enter the changes and then select File>Save As, giving a new name. 
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- Leader Field - 

Leader Field 
The Leader or Directory Field is the first field of a bibliographic record. It consists of 
information that defines the parameters for processing the record. 

In Voyager the Leader field appears at the top of the MARC record display with the other 
fixed fields. It is displayed as a grid. 

Click the Leader button: 

 

 

 
The fields to enter are: 
Record Status (can be used in changing record formats), 
Type of record (can be used in changing record formats), 
Bibliographic Level 
Type of Control 
Encoding Level 
Cataloguing Form 
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- Leader Field - 

However the Leader fields already contain the correct values because they are entered in the 
templates.  The values used by the ILO Library are the following. 
 
Record Status 
Position in field 5. Length 1. 
  n new 
It will automatically change to "c" (Corrected or revised) the first time the record is saved in 
Voyager. 
 
Type of Record  
Position in field 6. Length 1. 
 
  a Printed language material 
  g Projected medium (films, videocassettes) 
  m Computer file 
 
Bibliographic Level  
Position in field 7. Length 1. 
 
  a Monographic component part (for historical reasons used not just for 

analytic of a book but also for analytics of a serial publications) 
  m Monograph/Item (for monographs, CD-ROMs, videocassettes, etc.) 
  s Serial 
 
Type of Control 
Position in field 8. Length 1. 
 
  blank No specified type of control 
 
Character Coding 
Position in field 9. Length 1. 
 
  blank MARC8 
 
Encoding Level 
Position in field 17. Length 1. 
Indicates the level of cataloguing: 
   
  blank Full-level cataloguing by OCLC members 
   
Descriptive Cataloguing Form 
Position in field 18. Length 1. 
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blank Record is catalogued according to AACR2 rules 



- Leader Field - 

CHANGING RECORDS FORMAT 
 
Changing Between Monographs and Serials:  

In the Leader display, click Bibliographic Level. Choose the one you wish to change to: m 
to s for example. 

When you are finished, click OK. You will get the following message: 

Changing the record format will invalidate the current 008. Proceed anyway? 

Choose Yes. Now click on the 008 button (see next chapter “008 Fields”) to get the full 
display. Subfields appropriate for the bibliographic format will be displayed Change any fied 
that need modifying, paying attention to Publication Status and Date 2 as well as those that 
are format specific. When finished. Click OK. 

If you change the TYPE OF RECORD subfield you will need to follow a similar procedure.  
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 - 008 Fields - 

008 FIELDS 
 

 
The 008 fixed field has different subfields depending on Type of Record and Bibliographic 
Level codes in the Leader. 

It appears at the top of the MARC record display with the Leader and the other fixed fields. It 
is displayed as a grid. 

Click the 008 button: 
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A list will appear of 008 fields that the Library uses with the values used. 



 - 008 Fields - 

Publication Status 
 s Single known date/probable date (for monographs, computer files, etc.). 
 c Serial item currently published (for serials life). 
 d Serial item ceased publication (for serials no longer published). 
Date 1 

Type the date of publication. 
For a serial enter the date of publication the first number. 
If the date is unknown enter the most probable date or decade as follows: 199u, 200u. 

Date 2 
 For serials no longer published: enter the date of publication of the last number. 
 For monographic serials or multivolume monographs: enter the date of publication of 
the last volume. 
Place of Publication 
 Select the country of publication from the grid. 
Illustration 1 
 _ no illustrations 
 a for illustrations in general 
 d for statistics: graphs, tables, etc.  
Form of Item 
 _ none of the following (by default) 
 s for electronic documents (e-doc, e-ser)  
Contents 1 
 _ no specified nature of contents 
 b if the document contains bibliographic references 
Govt. Publication 
 _ not a government publication 
 i for international or intergovernmental organizations’ documents 
 f for federal or national institutions’ documents 
Language 
 Select the language of the document from the grid 
Cataloguing source 
 d always select  d 
 
Special fields to enter for serials 
  
Frequency 
 Select the frequency of the serial from the grid. 
Regularity 
 Select the regularity of the serial from the grid. 
Type of Serial 
 p periodical 
 
Special fields to enter for videocassettes 
 
Type of material 
 v videorecording 
 z other type of material (DVD)  
Technique 
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0XX FIELDS (Control fields) 
 

 
020  INTERNATIONAL STANDARD BOOK NUMBER (ISBN) 
 
 Required if the document has an ISBN BKS 
 Repeatable 
 
Indicators  none 
 
Subfields used: 
$a  ISBN: entered without dashes; a qualifier can be added in parentheses; 
  if the final character is X, use upper case 
$z  invalid ISBN  
 
Examples: 
 
020  $a 0684142589  
020  $a 922110359X (pdf) 
020  $a 9221171205 (html) 
020  $a 3878779798 (v.1) 
020  $z 3878770970 
  
 
022 INTERNATIONAL STANDARD SERIAL NUMBER (ISSN) 
 
 Required if the document has an ISSN SER 
 Repeatable 
 
Do not use for BKS or ANA. For BKS enter ISSN in field 440 (Series Statement) and for 
ANA in field 773 (Host Item Entry) in subfields $x. 
 
1st indicator  0 
2nd indicator  none 
 
Subfields used : 
$a  ISSN: two groups of four characters separated by a dash; if there is an X, enter it in 

upper case 
$z  invalid ISSN 
 
Examples: 
 
022   $a 0044-8399 
022   $a 0834-0674 $z 0532-9779 
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035  SYSTEM CONTROL NUMBER 
  
 Optional BKS SER ANA 
 Repeatable 
 
Entered automatically by the system. 
Contains the the bibid of the record. 
For old records created before Voyager there are two iterations of 035: 

- one containing the new bib id from Voyager and 
- the other with the old record number (“ISN”) of the record transferred from the now 
defunct LMARC database with the mention “ilb”. 
 

Examples: 
035 $a 375409 
035 $a ilb196793 
 
 
040 CATALOGUING SOURCE 
  

BKS SER ANA 
Not repeatable 

 
Code of the institution which catalogued or modified the record. 
See also Source (fixed field). 
 
Indicators none 
 
Subfields used: 
$a  original cataloguing agency 
$c  agency responsible for data entry (entered automatically) 
$d  agency responsible for modification of the record 
 
Example: 
Source d 
040 $a ILO $c ILO 
 
 
041 LANGUAGE CODE 
  

Required if the document is in more than one language 
BKS SER ANA 

 Not repeatable 
  
When 041 is present, add the 546 field Language Note. 
 
Enter if: 
-the document is in more than one language 
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-the languages of summaries, abstracts, accompanying material or table of contents are 
different from the language of the main text. 



 

Enter up to six language codes in subfield $a.  If the text includes more than six languages, 
enter the code for the language of the first title followed by “mul” (multilingual). 
 
1st indicator  0 the document is not a translation or does not include a 

translation 
1 the document is or includes a translation 

2nd indicator  none 
 
Subfields used: 
$a  code of the language of main text (first code should be the same code as in the fixed 

field Lang, enter other codes in order of importance in the text)     
$b  code of the language of summary or abstracts 
$f  code of language of table of contents 
$g  code of language of accompanying material  
 
Examples: 
 
1. A document in English, French, and Spanish
008 Language: eng 
041 0   $a engfrespa 
546 $a Text in English, French and Spanish 
 
2. A French-English, English-French dictionary with title in English
008 Language: eng 
041 0   $a engfre 
546 $a Text in English and French 
 
3. A document in French with an introduction or appendices in English and Arabic
008 Language: fre 
041 0   $a freengara 
546 $a Text in French, introduction and appendices in English and Arabic 
 
4. A document in English, French, German, Spanish, Russian, Japanese, Arabic
Lang: eng 
041 0   $a engmul 
546 $a Text in English, French, German, Spanish, Russian, Japanese and Arabic. 
 
 
049 LOCAL HOLDINGS 
 
No longer used. Replaced by MARC format holdings records. 
 
 
072 SUBJECT CATEGORY CODE/ILO FACET 
  
 Optional BKS SER ANA 
 Repeatable 
 
1st indicator  none 
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2nd indicator  7, present if source of code is given in subfield $2 



 

 
Subfields used: 
$a  subject category code / ILO facet number from ILO Thesaurus 
$2  source of code (ilot for ILO Thesaurus) 
 
Example: 
 
072 7 $a 03.04.4 $2 ilot 
 
 
088 REPORT NUMBER 
  
 Required if found on the document  BKS SER 
 
For documents already catalogued by another library: if the RN is not in the 088 field, 
transfer the information to this field. 
 
Indicators none 
 
Subfield used: 
$a  report number 
 
Examples: 
 
For an ILO Governing Body document 
 
088   $a GB.264/PFA/4/2 + (Corr.) + (Add.) 
 
Note: there is a space before and after “+”. 
 
For a United Nations conference document 
 
088   $a A/CONF.177/20 
 
 
092 LOCAL DEWEY NUMBER 
 
 Optional BKS SER 
 
Entered for the Reading Room collection. 
 
1st indicator none 
2nd indicator 9, local class scheme 
 
Subfield used : 
$a local Dewey number 
 
Example: 
092 $a R413.1 
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099 LOCAL FREE-TEXT CALL NUMBER 
 
 Mandatory BKS SER ANA  
 Repeatable 
 
Use for ILO call numbers (CALLNO). 
Important: once the record saved in the database add “NEW HOLDINGS” (See chapter on 
“Original Cataloguing in Voyager”, section “Adding mfhd records”. The system will 
automatically create a record with the callno entered in 099. When searching by Mfhd Call  
Number the system looks for the information in the holding record not in the bibliographic 
one. 
 
1st indicator  none 
2nd indicator  9 (local class scheme) 
 
Subfields used: 
$a  call number 
 
Examples: 
 
for monographs 
 
099  9 $a 95A603 
 
for serial 
 
099  9 $a P09681 
 
for electronic documents 
 
099 9 $a WWW ACCESS ONLY 
 
for analytics 
099 9 $a 40203(2005-501)1-80 
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 - 1XX Fields - 

1XX FIELDS (Main entries) 
 
 
100 MAIN ENTRY - PERSONAL NAME  
  
 BKS SER ANA 
 Not repeatable 
 
Enter the personal name main entry, with all its forenames, in subfield $a. Other subfields 
can be used if the entry has been taken from an authority list (for example subfield $c, titles 
or $d, dates) but use only $a to create a new authority. 
 
If responsibility is attributed to two or three authors, then the main entry (100, 110, 111) is 
the name of the first author and the names of the others are entered as added entries (700, 
710, 711). 
 
When the document is a monograph with multiple authors (more than three) do not use 
field 100.  Enter the first mentioned name on the title page and “...[et al.]” in 245 $c, and 
create an added entry (700,710,711) for that co-author. 
 
An exception to that rule are ILO publications. In this case, even when there are more than 
three authors, mention all of them in 245 $c and create added entries for all of them. 
 
Editors and compilers are never entered in a main entry (100). Added entries (700) must be 
created for them. 
 
1st indicator  1 
2nd indicator  none 
 
Subfields used: 
$a  name (surname and forename(s)) 
 
Examples: 
 
1. English language authors
100 1  $a De Sola, Ralph. 
100 1  $a Vaughan-Whitehead, Donald. 
 
2. French language authors
100 1  $a SΠve, Martin de. 
100 1  $a Du Bled, Simon. 
 
3. Spanish language authors
100 1  $a Márquez Garmendia, Martha 
100 1  $a Las Heras Borrero, Fernando. 
  
For other examples see AACR rules. 
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110 MAIN ENTRY - CORPORATE NAME 
 
 BKS SER ANA  
 Not repeatable 
 
Enter the main entry under the corporate body if the document belongs to one of the 
following categories: 
a) those of an administrative nature, dealing with the corporate body itself 
or its internal policies, procedures, finances, and/or operations 
or its officers, staff, and/or membership (e.g., directories) 
or its resources (e.g., catalogues, inventories); 
b) some legal, regulatory works: 
laws, decrees of the chief executive that have force of law, administrative regulations, 
constitutions, court rules, treaties, court decisions, legislative hearings, etc.; 
c) those that record the collective thought of the body (e.g. reports of commissions, 
committees, etc.; official statements of position on external policies); 
d) those that report the collective activity of a conference (e.g. proceedings, collected 
papers), or of an event (e.g., an exhibition), provided that the conference or event is 
prominently named in the item being catalogued. 
In case of doubt treat the document as if it belongs to none of these categories and 
create 710 entries.  Normally 710 field appears more frequently than 110 field. 
 
Headings: 
 

Language for International Organizations:  If the name appears in English on items 
issued by the organization, use English.  If not, use the form in the official language 
of the body, or if the official language is not known, use the form in the language used 
predominantly in items issued by the body.  In case of doubt, use the following 
languages by order of preference:  English / French / German / Spanish / Russian. 
Governments and government agencies:  The conventional name of a government is 
the geographic name (AACR2, 23, Geographic Names, 24.3E) of the area (country, 
province, state, county, municipality, etc.) over which the government exercises 
jurisdiction.  Language:  Use the English form of the geographic name when it exists, 
otherwise enter the name in the official language of the country.  Use the official 
language of the country for the name of the government subdivision.  In case of 
doubt, use the following languages by order of preference:  English / French / German 
/ Spanish / Russian. 
Language for non-governmental national or local corporate bodies:  Use the official 
language of the organization.  If the organization has more than one official language 
and one of these is English, use English.  If English is not one of the official 
languages of the organization, or if the official languages is not known, use the form 
in the language predominantly used in publications issued by the organization.  In 
case of doubt, use the following languages by order of preference:  English / French / 
German / Spanish / Russian. 
 

 NOTE: In fields 110 and 710 enter Dept. for Department. 
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1st indicator (type of name)  1 government and public administration 
(geographic name) 

2 all other corporate bodies (including 
international organizations) 

2nd indicator    none 
 
Subfields used: 
$a  corporate name 
$b  subordinate unit(s) 
$c  conference place 
$d  conference date 
$n  session number of conference  
 
Examples: 
 
110 2 $a International Labour Office. $b Bureau of Library and Information Services. 
110 1 $a Mexico. $b  Dirección General de Conciliación. 
110 2 $a University of Leeds. $b Dept. of Social Policy and Health Service Studies. 
110 2 $a Université de Bordeaux. $b Faculté de droit et des sciences économiques. 
 
Example of corporate body with a conference subheading: 
 
110 2 $a United Nations. $b General Assembly $n (50th : $d 1995 : $c New York, N.Y.) 
 
 
111 MAIN ENTRY - MEETING NAME 

    
 BKS SER ANA  
 Not repeatable 
 
Use the conference as the main entry for publications that record the activities of the 
conference (proceedings, collected papers, etc.). However, the conference name must appear 
prominently in the item being catalogued. 
If the document is the report of the conference it is entered as an added entry (711).  
 
1st indicator  2 name of the conference 
2nd indicator   none 
 
Subfields used: 
$a  name of the conference 
$c  place of the conference (use the English form if there is one in general use) 
$d  date of the conference 
$e  subordinate unit 
$n  number of session (always in the English form) 
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Examples: 
 
111 2 $a Name of the conference $n (number of session : $d date :$c Place, Country in 
English) 
111 2 $a International Labour Conference $n (93rd : $d 2005 : $c Geneva, Switzerland) 
111 2 $a International Conference on Data Processing in the Field of Social Security $n (7th : 
$d 1994 : $c The Hague, Netherlands) 
111 2 $a Joint Meeting on the Impact of Structural Adjustment on Educational Personnel $d 
(1996 : $c Geneva, Switzerland) 
 
Example of a Conference with a subheading (subordinate unit): 
 
111 2 $aUnited Nations Conference on Human Settlements $n (2nd : $d 1996 : $c Istanbul, 
Turkey). $e Dialogue for the 21st century on the Future for Urban Employment 
 
 
130 MAIN ENTRY - UNIFORM TITLE  
  
 BKS SER ANA 
 Not repeatable 
 
This field is not usually used by the Library. 
When can a main entry-uniform title be found in Labordoc? When two or more serial 
publications have the same title, a main entry uniform title is added with the name of the 
publication and some kind of identification in parentheses.  The chosen identification is 
generally the place of publication. (Preliminary articles are omitted, so the 1st indicator 
(which in other fields indicates the number of characters to ignore in sorting) is always zero).  
 
1st indicator   0 
2nd indicator  none 
 
Subfields used: 
$a  uniform title 
 
Examples: 
 
130 0 $a Industrial Relations Journal (Karachi, Pakistan) 
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130 0 $a Industrial Relations Journal (Oxford, U.K.) 
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 - 2XX Fields - 

2XX FIELDS (Title, Statement of 
Responsibility, Edition and Publication) 

 
 
240 UNIFORM TITLE 
 
 BKS SER  
 Not repeatable 
 
This field is reserved for an uniform title which follows a main entry.  Its main use for the 
ILO is for legislation and annual reports: 
- Use Laws, etc. as a uniform title for legislative texts of a political body, excluding 
compilations on a particular subject.  The main entry is the name of the political jurisdiction 
always in English (for example: France). 
- Create na uniform title for an "annual report" or similar publications (if they are 
catalogued as monographs-see the example below), when different editions of the same 
publication bear different titles and/or have different personal or corporate authors. 
 
1st indicator  1 
2nd indicator  0 
 
(Note: the 2nd indicator gives the number of characters to be ignored in sorting, but it is 
always zero since initial articles are not used in uniform titles). 
 
Subfields used: 
$a  uniform title 
$d  date of the signature of the treaty 
$g  other signatory of the treaty 
 
Exemples: 
 
110 1   $a Alaska. 
240 10 $a Laws, etc. 
 
110 1   $a France. 
240 10 $a Lois, etc. sur la sécurité sociale. 
 
110 1   $a Slovenia. $b Republiski zavod za zaposlovanje. 
240 10 $a Annual report (1995) 
 
110 1   $a World Economic Forum 
240 10 $a Annual report (1996) 
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242 TRANSLATION OF TITLE BY CATALOGUING AGENCY 
 
 Optional 
 Repeatable 
 
Use this field if the translated title does not appear in the title page.  Follow instructions for 
field 245. 
 
1st indicator  1 
2nd indicator  0-9 Number of nonfiling characters 
 
Subfields used: 
$a  title 
$b  subtitle 
$c  statement of responsibility 
$y  language of translated title 
 
Example: 
 
A document in Japanese: 
242 10 Introduction to the ILO : $b its structure and activities and main Conventions and 
Recommendations. $y eng 
245 10 ILO no aramashi : $b karsudo... (transliteration of the Japanese title). 
 
 
245 TITLE STATEMENT 
 
 Mandatory BKS SER ANA  
 Not repeatable 
 
Source of information:  title page, added title pages or the part of the item supplying the most 
complete information (e.g. cover page). Enter any information found elsewhere than the chief 
source of information in square brackets. 
Transcribe the title and subtitle/s in the order indicated by the sequence on, or the layout of, 
the chief source of information. 
The title field includes the title, other title information such as subtitle, parallel title (title in 
an other language), the medium (if it is a videocassette, an electronic resource,etc.), a 
statement of responsibility, and complementary information (e.g. the title of a special theme 
in an analytic record).  These elements are entered as they appear on the title page (in case of 
multiple authors, see explanations in 100 FIELD). As much information as possible is 
included in the statement of responsibility reproducing accurately the source of information. 
 
1st indicator  1 
2nd indicator  0-9 number of nonfiling characters (If the title does not begin with 

an article, enter 0. If the title begins with an article, enter the 
number equivalent to the number of characters in the article, 
plus the spaces, the punctuation, and the diacriticals which 
precede the first significant word. See annex). 
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Subfields used: 
$a  title 
$b  subtitle, parallel title(s) (only use one subfield b) 
$c  statement of responsibility 
$h  medium (can be written in the language of the document if it is in one of the ILO 
official languages,English, French, Spanish): CD ROM, electronic resource, resource 
électronique, recurso electrónico videocassette, vidéocassette, DVD) 
$n  number of part/section 
$p  title of part/section 
 
Examples: 
 
1. 
 
245 13 $a Le travail dans le monde. 
 
245 12 $a L’espace… 
 
245 10 $a Credit schemes for the rural poor : $b some conclusions and lessons from practice  
/ $c S. Tilakaratna. 
 
245 10 $a Decentralisation and poverty in developing countries $h [electronic resource] : $b 
exploring the impact / $c by Johannes Jütting ... [et al.]. 
 
 2. Parallel titles
 
245 10 $a Title : $b subtitle / $c Author(s) = Title : subtitle / Author(s) 
245 10 $a Title = $b Title / $c Author(s) 
 
245 10 $a Tekstiiliteollisuuden vuosikirja = $b The textile industry yearbook. 
 
245 10 $a Proceedings : $b 28th General Assembly / $c International Social Security 
Association = Comptes rendus : 28e Assemblée générale / Organisation internationale de la 
sécurité sociale = Actas : 28a Asamblea General / Organización Internacional de la Seguridad 
Social = Protokoll : 28. Generalversammlung / Internationale Vereinigung für Soziale 
Sicherheit. 
 
3. Title with a title of part/section
 
245 10 $a Title. $n Number of part, $p Title of part. 
 
245 10 $a Polymer science. $n Part A, $p General papers. 
 
4. Title with the “General material designation” 
 
245 10 $a Economically active population, 1950-2010 $h [CD ROM] / $c Bureau of 
Statistics, International Labour Office. 
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5. Analytics, special topic
 
245 10 $a International financial flows and development [special topic] / $c edited by 
Maxwell J. Fry and Victor Murinde. 
 
245 10 $a Prevention of occupational dermatoses. $p [Special topic :] Occupational allergies / 
$c Edward A. Emmett. 
 
For more information see the chapter on “Examples of Entire Records”, “Specifications for 
cataloguing analytics: special topic”. 
 
6. Two titles without a collective title
 
245 10 $aDel Art. 539 del Código de Trabajo ;$bDel Presidente de la Corte de Trabajo como 
Juez de Referimientos / $cLupo Hernandez Rueda. 
 
 
246 VARYING FORM OF TITLE 
 
 Required when varying forms of the title appear on the document BKS SER 
 Repeatable 
 
Initial articles are generally not recorded in field 246. 
For any form of the title different from that entered in field 245, and for parallel titles. 
 
1st indicator  1 

3 if 2nd indicator is a blank 
 
2nd indicator (indicates type of title) 

* no information 
0 portion of title (use when the variant title is only a part of the 

whole title, or is an alternative title) 
1 parallel title (use when the title in field 245 is followed by a 

parallel title) 
2 distinctive title (use for yearbooks when the individual volume 

is likely to be known by its special title) 
3 other title 
4 cover title 
5 added title page title (generally in another language) 
6 caption title (title at top of first page of text) 
7 running title (title at top or bottom of each page) 
8 spine title 

 
Subfields used: 
$a  title or short title (without introductory articles) 
$b  remainder of title (subtitle) 
$n  number of part/section 
$p  name of part/section 
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Examples: 
 
Book with a cover title different from title on title page 
 
245 10 $a Travail et lien social. 
246 14 $a Travail et non-travail dans la société demain : $b réflexion prospective. 
 
Parallel titles
 
245 10 $a ILO Thesaurus : $b labour, employment and training terminology / $c International 
Labour Office, Central Library and Documentation Bureau = Thesaurus BIT : terminologie 
du travail, de l'emploi et de la formation / Bureau international du Travail, Bureau central de 
bibliothâeque et de documentation = Tesauro OIT : terminología de trabajo, empleo y 
formación / Oficina Internacional del Trabajo, Oficina Central de Biblioteca y 
Documentación = IAA Thesaurus : Terminologie der Arbeit, Beschäftigung und  Ausbildung 
/ Internationales Arbeitsamt, Abteilung Zentrale Bibliothek und  Dokumentation. 
246 11  $a Thesaurus BIT : $b terminologie du travail, de l'emploi et de la formation. 
246 11  $a Tesauro OIT : $b terminología de trabajo, empleo y formación. 
246 11  $a IAA Thesaurus : $b Terminologie der Arbeit, Beschäftigung und Ausbildung. 
 
245 12 $a A load too heavy : $b children in mining and quarrying / $c International Labour 
Office = Un fardeau trop lourd : les enfants qui travaillent dans les mines et l'extraction 
minière / Bureau international du Travail = Una carga demasiado pesada : niños que trabajan 
en minas y canteras / Oficina internacional del Trabajo. 
246 11 $a Fardeau trop lourd : les enfants qui travaillent dans les mines et l'extraction 
minière. 
246 11 $a Carga demasiado pesada : niños que trabajan en minas y canteras. 
 
Part/section of a title 
 
245 10 $a Labour Code. $n Volume IV, $p Law no. 99/2003, August  
246 10 $a Law no. 99/2003, August 
 
 
247 FORMER TITLE OR TITLE VARIATIONS 
 
 SER 
 Repeatable 
 
If separate records are not created when there is a change in a serial title add the latest title in 
245 and the former title.in 247. 
 
1st indicator  1 
2nd indicator  0 
 
Subfields used: 
$a  title 
$x ISSN 
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Examples: 
 
245   $a Country report. $p Barbados, British Virgin Islands, Cayman Islands, Netherlands 
Antilles, Aruba.  
247   $a Country report. $p Bahamas, Barbados, Bermuda, British Virgin Islands, 
Netherlands Antilles, Aruba, Turks and Caicos Islands, Cayman Islands $x 1351-8674 
 
 
250 EDITION STATEMENT 
 
 Required if document is not a first edition BKS SER 
 Not repeatable 
 
Transcribe in the language of the document. 
Source of information: title page, preface, colophon (printer's statement on last page of 
document), imprint. 
 
Indicators none 
 
Subfields used: 
$a  edition statement 
$b  remainder of edition statement 
 
Examples: 
 
250   $a 3rd ed. 
250   $a 2nd ed. / $b edited by Larry C. Lewis 
250   $a 1995 ed. 
250   $a 2. Aufl. 
250   $a 2e éd., rev. et corr. 
 
 
260 PUBLICATION, DISTRIBUTION, ETC. (IMPRINT)  
  
 Mandatory BKS SER ANA 
 
Transcribe in the language of the document. 
Source of information: title page, preface, colophon (printer's statement on last page of 
document), imprint. 
If the publisher’s name appears in any other field fully written, then use the publisher’s 
acronym in this field.  But for short acronym names with less than three letters such as: 
United Nations (UN) or World Bank  (WB), use the full name. 
 
Make and added entry (710) for publishers if the responsibility of the work extends beyond 
that of merely publishing the item catalogued.   
 
Indicators none 
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Subfields used: 
$a  place of publication (can be repeated) 
$b  publisher's name (can be repeated) 
$c  date of publication (can be repeated) 
 
Examples BKS 
 
260   $a Geneva : $b ILO, $c 1995. 
260   $a New York ; $a London : $b Oxford University Press, $c 1994. 
260   $a Nairobi : $b Habitat ; $a Geneva : $b ILO, $c 1995. 
 
Example of a document published by a personal author 
 
245 10 $a Environnement et emploi : $b experiences francaises / $c Jean-Berneard Célestin. 
260      $a Paris : $b J.B. Célestin, $c 1996. 
 
Examples SER 
 

 67

260   $a Geneva : $b ISSA, $c 1947- 



 - 2XX Fields - 

 68



 

 
 
 
 

3XX FIELDS 
 

 69

 



 - 3XX Fields - 

 70 



 - 3XX Fields - 

3XX FIELDS (Collation, Frequency, 
Numbering) 

 
 
The 3xx fields can be written in the language of the document if it is in one of the ILO 
official languages (English, French, Spanish) 
 
300 PHYSICAL DESCRIPTION 
 
 Mandatory BKS SER ANA 
 Repeatable 
 
Indicators none 
 
Subfields used: 
$a  collation; (disregard unnumbered sequences, unless such sequence constitutes the 
whole or a substantial part.  When recording the number of unnumbered pages, either give 
the estimated number preceded by “ca.” (circa), without square brackets, or enclose the exact 
number in square brackets; if the volume has complicated paging, then enter  “1 v.”) 
$b  other elements of the collation: ill., statistics, statistiques or estadísticas (in the 
language of the document if it is English, French or Spanish and in English for documents in 
other languages) 
$c dimensions (not required) 
$e accompanying materials 
 
Examples: 
 
300 $a 327 p. 
300 $a xviii, 323 p. 
300 $a xviii, 273, xviii, 276 p.  
300 $a 3 v. 
300 $a ca. 300 p. 
300 $a [93] p. 
300 $a  1 v. 
300      $a  iii, 39 p., [23] leaves 
300      $a 1 portfolio (29 booklets) 
300 $a 1 brochure 
300 $a 1 folleto 
300 $a1 loose-leaf 
300 $a 1 carpeta 
300 $a 245 p. : $b ill. 
300 $a 340 p. : $b statistics 
300 $a 387 p. : $b ill. ; + $e CD ROM 
 
300      $a 1 videocassette (VHS) (52 min.) : $b sd. col. 
300  $a 1 CD ROM 
300 $a 1 DVD 
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Examples of periodicals 
 
300  $a 103 v. 
300  $a v. 
 
Example of articles:  
 
300  $a p. 35-42 : $b ill. 
 
 
310 CURRENT PUBLICATION FREQUENCY  
 
 Required SER 
 Not repeatable 
 
Indicators none 
 
Subfields used: 
$a  current publication frequency (always in English) 
$b  date of current publication frequency: use when the beginning date of the current 
frequency is not the same as the beginning date of publication 
 
Example: 
 
310   $a Monthly 
 
 
321 FORMER PUBLICATION FREQUENCY 
 
 Required if the periodical has changed frequency SER 
 Repeatable 
 
When a periodical has changed frequency several times, enter the new frequency in field 321 
and add a note explaining former frequency changes. 
 
Indicators none 
 
Subfields used: 
$a  former frequency 
$b  dates of former frequency 
 
Example: 
 
310   $a Monthly, $b 1990-1996 
321   $a Five issues yearly, $b 1986-1989 
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362 DATES OF PUBLICATION AND/OR VOLUME DESIGNATION 
 
 Required when cataloguing the first issue of a periodical   SER 
 Repeatable 
 
1st indicator  0 if date is numeric and expressed as in AACR2 

1 if date is explained in the form of a note 
2nd indicator  none 
 
Subfields used: 
$a  dates of publication and numbering (use standard abbreviations and Arabic numerals, 

leave four spaces after the dash) 
 
Examples: 
 
362 0 $a Vol. 1, no. 1 (Jan./Mar. 1974)- 
 
If the periodical is closed, enter the numbering of the first and last issues: 
362 0 $a Vol. 1, no.1 (Sept./Oct. 1980)-v. 2, no. 3 (Jan./Feb. 1982) 
 
For successive numbering: 
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4XX FIELDS (Collections and Series) 
 
 
Introduction: 
Fields 4XX  reproduce exactly the information found on the information source of the 
catalogued document.  There are three different possibilities: 
 
1. Use 440 field: if the series title given in the document matches the series title form traced 
for the series authority (established in the Authority Database), use field 440 for the series 
statement. 
 
2. Use 490, first indicator 1, and 830 field: if the series title given in the document differs 
from the series title form traced for the series authority use field 490 for reproducing the 
series title given in the document and field 830 for the established form of  the series. 
 
3. Use 490, first indicator 0: if the series is not traced (for example when there is just one 
number of the series in the collection, etc., a series authority is not created). 
 
 
440 SERIES STATEMENT/ADDED ENTRY-TITLE 
 
 BKS required for monographs in a collection   
 SER use when item catalogued is in fact a sub-series    
 Repeatable (a document may belong to several collections) 
 
1st indicator  none 
 
2nd indicator  0-9 number of nonfiling characters (If the title does not begin with 

an article, enter 0. If the title begins with an article, enter the 
number equivalent to number of characters in the article, plus 
the spaces, the punctuation, and the diacriticals which precede 
the first significant word. See annex.) 

Subfields used: 
$a  title of collection 
$n  number of sub-collection 
$p  title of sub-collection 
$v  number of this volume in the collection (use Arabic numerals) 
$x  ISSN 
 
Examples: 
 
440 $a Title of the collection : subtitle, $x ISSN ; $v Number in the collection. $n Number of 
the sub-collection, $p Title of the sub-collection ; $v Number of this volume 
440  0 $a Development co-operation review series ; $v no. 8 
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490 SERIES STATEMENT 
 
 BKS Required for monographs in a collection  
 SER use when item catalogued is in fact a sub-series    
 Repeatable (a document may belong to several collections) 
 
1st indicator  0 series not traced 
   1 series traced differently 
 
2nd indicator  none 
 
Subfields used 
 
$a  collection/series statement: title of the collection, parallel title of the collection, 

subtitle, responsibility for the  collection 
$v  volume number 
$x  ISSN 
 
See examples in 830. 
 
 
830 SERIES ADDED ENTRY - UNIFORM TITLE 
  
BKS SER 
 
1st indicator  none 
 
2nd indicator  0-9 number of nonfiling characters (If the title does not begin with 

an article, enter 0. If the title begins with an article, enter the 
number of characters in the article, plus the spaces, the 
punctuation, and the diacriticals which precede the first 
significant word. See annex.) 

 
Subfields used: 
$a  title of collection 
$n  number of sub-collection 
$p  title of sub-collection 
$v  number of this volume in the collection (use Arabic numerals) 
 
Punctuation: 
830  0 $a Title of the collection : subtitle ; $v Number in the collection. $n Number of the 
sub-collection, $p Title of the sub-collection ; $v Number of this volume. 
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Examples: 
 
1. 
 
490 1  $a Working paper ; $v WP.1/1997 
830  0 $a Working paper (International Labour Office. Working Conditions and Environment 
Dept. Conditions of Work and Welfare Facilities Branch) ; $v WP.1/1997. 
 
2. 
 
490 1   $a Policy research working paper ; $v 1906 
830   0 $a Policy research working papers ; $v 1906 
 
3. 
 
490 1   $a Discussion paper, $x 1012-6511 ; $v DP 98 
830   0 $a Discussion paper (United Nations Research Institute for Social Development) ; $v 
98 
 
4. A series which has an established name in English but which publishes volumes in French 
 
490 1 $a ThΠme 3 Population et conditions sociales. Séries C Comptes, enquΛtes et 
statistiques 
830  0 $a Theme 3--Population and social conditions. $n Series C, $p Accounts, surveys, and 
statistics. 
 
5. In the same document we can find two cases 
 
440  0 $a Theme 0--Miscellaneous. $n Series D, $p Studies and research 
490 1  $a Statistical document 
830  0 $a Statistical document (Statistical Office of the European Communities) 
 
6. When there are parallel titles 
 
490 1  $aTheme 3 Population and social conditions. Series C Accounts, surveys and statistics 
= $a ThΠme 3 Population et conditions sociales. Séries C Comptes, enquΛtes et statistiques 
830 0 $a Theme 3--Population and social conditions. $n Series C, $p Accounts, surveys, and 
statistics. 
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5XX FIELDS (Notes Fields) 
 
 

The notes fields can be written in the language of the document if it is in one of the ILO 
official languages (English, French, Spanish) 

 
500 GENERAL NOTE 
 
 BKS SER  
 Repeatable field 
 
Use this field for bibliographic information which does not appear elsewhere in the record. 
 
Indicators  none 
 
Subfields used: 
$a  general note 
 
Examples: 
 
500   $a Previous study: "World agriculture : towards 2000 : an FAO study", London, 
Belhaven Press, 1988. 
 
500   $a Also published by the ILO, Budapest, 1994, ISBN 92-2-109676-9. 
 
500   $a Issued as a complementary report to the report to the Government of Fiji on reform 
of the Fiji national provident fund pension scheme, presented by the ILO in 1993. 
 
500   $a Also published in the International Encyclopaedia for Labour Law and Industrial 
Relations, vol. 1. 
 
500    $a Offprint from "Europe-Asia studies", Vol. 50, No. 8, 1998, p 1413-1446. 
 
500    $a Printed from website. 
 
500   $a Programme d'appui aux structures mutualistes ou coopératives d'épargne et de crédit. 
 
500   $a ILO/DANIDA Programme on Cooperative Development in Rural Areas. 
 
500   $a Discarded  
(for journals not longer received) 
 
500   $a Originally presented as a thesis, Université Laval, 1994, under the title: L'emploi de 
la preuve extrinsΠque en arbitrage des griefs au Québec. 
 
500   $a Inside title page: “Copyright [by the] International Labour Organization”. 
 
500    $a Also held on CD-ROM. 
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For CIPs (Cataloguing In Publication): 
 
500    $a Description based on the manuscript for publication. 
 
For electronic documents, WWW access only: 
 
500   $a Mode of access : World Wide Web (available in electronic format only). 
 
500   $a Description based on the Internet version. 
 
 
502 DISSERTATION NOTE 
 

Optional BKS  
 Repeatable field 
 
Use for theses, but if Based on, First published as, Also published as a thesis appear on the 
document, use field 500 instead. 
 
Indicators  none 
 
Subfields used: 
$a  thesis note 
 
Example: 
 
502   $a Thesis (M.A.)--Université de GenΠve, 1993. 
(M.A.) = masters degree, in French:  maîtrise 
(Ph.D.) = doctoral degree, in French:  doctorat. 
 
 
504 BIBLIOGRAPHY, ETC. NOTE 
 
 Optional BKS SER ANA 
 
Indicators none 
 
Subfields used: 
$a  bibliography note (in the language of the document) 
 
Example: 
 
504   $a References. 
504   $a Referencias. 
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505 FORMATTED CONTENTS NOTE 
 
 BKS SER 
 Required for all ILO documents and for compilations 
 
Titles of different parts of the document. May include statements of responsibility and 
volume numbers.  For informal notes, use field 500. 
 
1st indicator  0 contents 

1 incomplete contents (use if the entire item is not on hand and 
the note describes only what is available) 

2 partial contents (use if one or more parts or chapters are of 
particular interest) 

2nd indicator  * basic level 
 
Subfields used: 
$a  formatted contents note 
 
Examples: 
505 0  $a v.1. National and international dimensions on debt and adjustment in developing 
countries -- v.2. Impact of debt and adjustment at the household level in developing 
countries. 
 
505 0  $a Chapter 1. Changing patterns in the world of work -- Chapter 2. The transformation 
of world employment -- Chapter 3. Convergence or divergence in conditions of work 
worldwide? -- Chapter 4. Trends and issues in the governance of the world of work.. 
 
505 0 $a The International Labour Organization -- Context -- The International Programme 
on the Elimination of Child Labour (IPEC) -- The IPEC approach -- Child labour and 
international standards -- IPEC target groups -- Child labour in India -- Response at the  
national level -- ILO in India --Evolution of IPEC in India -- IPEC-funded interventions -- 
IPEC's target groups in India -- IPEC in India from 1992 to 1999 -- Direct action with 
children -- Family-support intervention --… 
 
505 0 $a Ethnicity, language and workplace: evidence from a new matched employee-
employer data set / David Neumark, Judith Hellerstein -- Endogenous discrimination, 
migration and the protection of ethnic minorities / Hillel Rapoport  -- Immigrants' language 
skills: the Australian experience in a longitudinal survey / Barry Chiswick, Yew Lee, Paul W. 
Miller. 
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506 RESTRICTIONS ON ACCESS NOTE 
 
 Required for confidential documents  BKS SER ANA 

Repeatable field. 
 
Indicators none 
 
Subfields used: 
$a  restrictions on access (copy the restriction indication on the document) 
 
Example: 
 
506   $a Confidential. 
506   $a Confidentiel. 
506   $a Confidencial. 
 
 
520 SUMMARY, ABSTRACT, ETC. NOTE 
 
 Optional BKS ANA  
 Repeatable field 
 
Used by indexers. 
 
1st indicator  8 
2nd indicator  none 
 
Subfields used 
$a  summary note 
 
Example: 
 
520 8  $a Based on a survey of seven industries in the private sector and two public services. 
Covers the characteristics of pay structure, the use of job evaluation and the make-up of total 
earnings. 
 
 
525 SUPPLEMENT NOTE 
 
 SER  
 Repeatable field 
 
Use to highlight a special issue or supplement that is not catalogued separately. 
 
Indicators  none 
 
Subfields used: 
$a  supplement note 
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Example: 
 
The journal L'Expansion includes supplements which are published irregularly: 
525   $a Supplements accompany some issues. 
 
 
538 SYSTEM DETAILS NOTE (FOR COMPUTER REQUIREMENTS) 
 
 BKS,SER  
 Repeatable field 
 
Indicators  none 
 
Subfields used: 
$a  Requirements 
 
Example: 
 
538   $a Requirements : Microsoft Windows Windows NT4 or Windows XP, 20 Mbyte hard 
disk space, CD-ROM drive Microsoft, compatible mouse, VGA display - 640 x 480 
minimum. Incompatible with Citrix servers. 
 
 
546 LANGUAGE NOTE 
 
 BKS SER ANA  
 Repeatable field 
 
Use for notes concerning the languages of the text.  Associate this note with codes in the 
fixed-field element Lang and the 041 field. 
 
Indicators none 
 
Subfields used: 
$a language note 
 
See  examples in 041 field. 
 
 
590 LOCAL NOTE 
 
 Optional BKS SER   
 Repeatable field 
 
Indicators none 
 
Subfields used: 
$a  local note 
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6XX FIELDS 
 
 
650 TOPICAL TERM - SUBJECT ADDED ENTRY 
  
 BKS SER ANA 
 
1st indicator  1 (primary descriptors) 
    2 (secondary descriptors) 
2nd indicator  7 (present if source of code is given in subfield $2) 
 
Subfields used: 
$a  descriptor from ILO Thesaurus 
$2  source of code: 
  ilot = ILO Thesaurus, for descriptors in English 
  tbit = Thesaurus BIT, for descriptors in French 
  toit = Tesauro OIT for descriptors in Spanish 
 
Example: 
 
650 17 $a child labour $2 ilot 
650 27 $a employment promotion $2 ilot 
 
 
655 INDEX TERM - GENRE FORM 
 
 BKS SER ANA 
 
1st indicator  none 
2nd indicator  7 (present if source of code is given in subfield $2) 
 
Subfields used: 
$a  descriptor from ILO Thesaurus 
$2  source of code: 
  ilot = ILO Thesaurus, for descriptors in English 
  tbit = Thesaurus BIT, for descriptors in French 
  toit = Tesauro OIT for descriptors in Spanish 
 
Example: 
 
655  7 $a ILO pub $2 ilot 
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7XX FIELDS (Added entries) 
 
If the reason for an added entry is not apparent from the body of the description, for example, 
the person or organization named in the added entry is not named in the statement of 
responsibility or elsewhere, then the cataloguer should provide a note explaining it. 
 
 
700 ADDED ENTRY - PERSONAL NAME 

 
BKS ANA  
Repeatable field 

 
See 1XX Fields and field 100 for more details and examples. 
 
 
710 ADDED ENTRY - CORPORATE NAME 
 
 BKS SER ANA 
 Repeatable field 
 
See explanations and examples for 1XX Fields and for field 110. 
 
Make and added entry (710) for publishers if the responsibility of the work extends beyond 
that of merely publishing the item catalogued.   
 
 
711 ADDED ENTRY - MEETING NAME 
 

BKS SER ANA  
Repeatable field 

 
See explanations and examples for 1XX Fields and for field 111. 
 
 
773 HOST ITEM ENTRY 
 
 Mandatory ANA 
 Repeatable field 
 
Identifies the whole document, for an analytic which is contained in a longer document, such 
as a journal. 
 
1st indicator  0 
2nd indicator  none 
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Subfields used: 
$d  place:  publisher, date of publication 
$g  relationship information: Vol., no., (year), p. (use arabic numerals, substitute roman 
numerals) 
$t  title of the related document (for analytics without subtitle/s)  
$x  ISSN of the related document 
 
Example analytic from a periodical publication 
 
773 0 $t Title of the periodical. $d Place of publication : Publisher. $g Vol., no. (year) $x 
ISSN 
 
773 0 $t International Labour Review. $d Geneva : International Labour Office. $g Vol. 134, 
No. 4-5 (1995) $x 0020-7780 
 
 
775 OTHER EDITION ENTRY 
  
 BKS ANA SER 
 
Enter only the documents of the other language versions catalogued in the Library. 
 
1st indicator               0 
2nd indicator              none 
 
Subfields used: 
 
$t       title of the related document (no longer added because it appears automatically in the 
OPAC as a result of the information entered in $w) 
$e      language of the related document (MARC codes) 
$w     control number of the related document (bibid) 
Example: 
 
775 0  $e eng $w 309384 
 
 
780 PRECEDING ENTRY  
  
 SER 
 Repeatable field 
 
When there is a change in a serial title and a new record is created for the new title, the old 
title is recorded in a 780. 
 
1st indicator  0 
2nd indicator  0 continues 

1  continues in part 
3 supersedes in part 
4 formed by the union of -- and -- 
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6 absorbed in part 
7 separated from 
 

Subfields used: 
$t  title of the related journal 
$x  ISSN of the related document 
 
Example: 
 
245 10 $a Lettre hebdomadaire de la FIDHS 
780 00 $t La lettre de la F.I.D.H. 
 
 
785 SUCCEEDING ENTRY 
  
 SER 
 Repeatable field 
 
When there is a change in a serial title and a new record is created for the new title, the old 
record is closed and a 785 is added with the new title. 
 
1st indicator  0 
2nd indicator  0 continued by 

1  continued in part by 
3 superseded in part by 
4 absorbed by  
5 absorbed in part by 
6 split into -- and -- 
7 merged with -- to form -- 

Subfields used: 
$t  title of the related journal 
$x  ISSN of the related document 
 
Example: 
 
245 13 $a La lettre de la F.I.D.H. 
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8XX FIELDS 
 
 
830 SERIES ADDED ENTRY - UNIFORM TITLE 
 
See 4XX fields. 
 
 
852 LOCATION/CALL NUMBER/BRNUM 
  
 BKS SER 
 
Used for ILO Library's "Browsing collection number" (BRNUM) 
(ILO Library's call number is in field 099) 
 
 
856 ELECTRONIC LOCATION ACCESS 
 
 Required if document has an URL, BKS SER ANA COM  
 Repeatable 
 
1st indicator  * no information 
   4 HTTP 
 
2nd indicator  * no information 
   0 resource 
   1 version of resource 
   2 related resource 
 
Subfields used: 
$3 identifiying part/aspects : 

Full text 
  Full text, last number 
  Full text, some issues 

Abstract 
Executive summary 
Tables of contents 
Tables of contents and abstracts 
Selected text   

  Related data 
 
$z  any other notes or instructions : 

Password available from INFORM 
  Access limited to ILO staff 

Access limited to ILO Geneva-based staff 
  Password required, access limited to ILO staff 
  Password required 
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$u Uniform Resource Locator (URL) 
$q  electronic format type: use in the case where a particular resource is in an unusual 
format 
 
Examples: 
 
856 41 $3 Full text $u http://www.oecd.org/dev/publication/tp1a.htm  
 
856 41 $3 Full text $u http://www.nber.org/papers  
 
856 40 $3 Full text: $u http://www.imf.org/external/pubs/ft/weo/1999/01/index.htm $q 
Adobe PDF files 
 
856 42 $3 Related data $u 
http://ilo.org/public/english/bureau/stat/techmeet/16thicls/repconf.htm 
 
856 41 $3 Tables of contents $u http://www.journals.tandf.co.uk/  
 
856 41$3 Full text $z Password available from INFORM $u http://www.eiu.com/  
 
856 41$3 Full text, from Vol. 15, no. 1  (1995) $u 
http://www.sciencedirect.com/science/journal/02684012  
 
856 41 $3Full text on Ebsco $z Access limited to ILO staff $u 
http://www.ilo.org/intracgi/oneclick.pl?Epub=102369  
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856 41 $3 Full text from World Bank $u 
http://www.ilo.org/intracgi/oneclick.pl?Wdid=0000949460009270532320 



 

 
 
 
 

9XX FIELDS 
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 - 9XX Fields - 
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 - 9XX Fields - 

9XX FIELDS (Local Processing 
Information) 

 
 
920 STATUS 
 
Indicators  none 
 
Subfields BKS ANA SER: 
$a atran: waiting for revision 
 btran: indexed waiting for biblio 
 biblio: final status 
 copy: waiting for copying descriptors from bibid record indicated in 923 field 
$d Date: yyyy-mm-dd 
 
Example: 
 
920 $a btran $d 2005-06-01 
  
 
923 FORMER PROISN 
 
Indicators  none 
 
Subfields BKS ANA SER: 
$a        $a bibid of the record from which we want to copy the indexing fields 
 
Example: 
 
923      $a 345678 
 
  
925 ABSTRACTOR ID 
 
Indicators  none 
 
Subfields BKS ANA SER: 
$a        $a indexer’s identity 
 
Example: 
 
925   $a aa 
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 - 9XX Fields - 

946 CATALOGUER ID 
 
Indicators  none 
 
Subfields BKS ANA SER: 
$a  cataloguer's identity:  
  - for original cataloguing enter cataloguer’s initials. 
  - for imported cataloguing enter cataloguer’s initials and the number 1. 
 
Example: 
 
946   $a aa 
946   $a aa1 
 
 
947 LOCAL PROCESSING INFO/COLLECTION 
 
Indicators  none 
 
Subfields BKS SER ANA: 
$b  revisor’s identity 
 
Subfields BKS: 
$c  collection source 
 
 
949 LOCAL PROCESSING INFORMATION/CONTROL 
 
By adding the “xx” to the 949$a subfield, we select books (articles) for the New Library 
Acquisitions list which appears every two weeks on the library website. 
 
Indicators  none 
 
Subfields: 
$a  [reserved for free text] 
$f collection management note 
 
Example: 
 
949    $a xx 
949    $f Illegible card 
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HOLDINGS 
RECORDS 
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 - Holdings records - 
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 - Holdings records - 

HOLDINGS RECORDS (MFHD) 
 
See section “Adding the mfhd records” in the chapter on Original cataloguing in Voyager. 
Holdings records in Voyager follow the: 
MARC FORMAT FOR HOLDINGS RECORDS(MFHD).  
They are very similar in appearance to bibliographic records. 
 

 
 
 
852 LOCATION/CALL NUMBER 
 
 Mandatory 
 
Contains the call number of the document. 
 
1st indicator 8 
2nd indicator none 
 
Subfields used : 
$b location (INF, e-doc, e-ser, etc., see location list) 
$h callno (105b0912, WWW ACCESS ONLY, etc.) 
$t copy number 
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 - Holdings records - 

Examples : 
 
852  8   $b INF $h 105A315 $t Copy 1 
852  8   $b e-doc $h WWW ACCESS ONLY 
 
 
856 ELECTRONIC LOCATION ACCESS 
 
See 8XX fields 
 
866 TEXTUAL HOLDINGS-GENERAL INFORMATION 
 
 Mandatory SER 
 Repeatable field 
 
Contains a textual description of the holdings of a basic bibliographic unit in the collections 
of the reporting organization. 
 
1st indicator none 
2nd indicator 0 
 
Subfields used : 
$a  holdings 
$z  kept and public notes 
 
Examples : 
 
866  0   $a v. 10- (2002-) $z Kept 5 years 
866  0   $a 2002- $z Kept 2 years 
866  0   $a v. 5:no. 3-v. 17:no. 4 (1976-1988) 
866  0   $a 1998:no. 1- 
866  0   $a 1999:Oct.- 
866  0   $a 1968- 
866  0   $a v. 36-49 (1961-1974) 
866  0   $a 1960-1975,1979-1990 
866  0   $a v. 36- (1984-) $z Published on CD-ROM : v.51(1999) 
866  0   $a 1975:Jan. 15- $z Printed version up to 1999:Feb. 20 ; check online version for 
subsequent holdings 
866  0   $z Connect to online version for holdings information 
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866  0   $z Latest issue online  



 

 
 
 
 

AUTHORITY 
RECORDS 
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 -  Authority records - 
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 -  Authority records - 

AUTHORITY RECORDS 
 
Authority records in Voyager are standard MARC records. They are very similar in 
appearance to bibliographic records. 
 

 
 
 
FIELDS: 
 
040 CATALOGUING SOURCE 
 
1st indicator none 
2nd indicator none 
 
Subfields used : 
$a ILO 
$c ILO 
  
Example : 
 
040 $a ILO $c ILO 
 
 
 

 113

 



 -  Authority records - 

100 HEADING – PERSONAL NAME 
 
1st indicator:  1 
2nd indicator:  none 
 
Subfields used: 
$a name (surname and forename) 
$b numeration 
$c titles and other words associated with a name 
$d dates associated with a name 
$e relator term 
 
Examples: 
 
100 1 $aMárquez Garmendia, Martha 
 
 
110  HEADING – CORPORATE NAME 
 
1st indicator:  1 government and public administration 

 2 all other corporate bodies 
2nd indicator:  none 
 
Subfields used: 
$a corporate name 
$b subordinate unit 
$c conference place 
$d conference date 
$n session number of conference 
 
Examples: 
 
110 2  $a International Labour Office 
110 1  $a Mexico. $b Dirección General de Conciliación 
110 2  $a International Labour Organisation. $b European Regional Conference $n (2nd 
:$d1968 :$cGeneva, Switzerland) 
 
 
111  HEADING – MEETING NAME 
 
1st indicator:  2  
2ond indicator: none 
 
Subfields used: 
$a name of the conference 
$c place of the conference 
$d date of the conference 
$n number of session 
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 -  Authority records - 

Example: 
 
111  2 $a International Labour Conference $n (93rd : $d 2005 : $c Geneva, Switzerland) 
 
 
130  HEADING – UNIFORM TITLE 
 
1st indicator: none 
2ond indicator: 0-9 number of nonfiling characters (if the title does not begin with 

an article, enter 0; if the title begins with an article, enter the 
number equivalent to the number of characters in the article, 
plus the spaces, the punctuation, and the diacriticals which 
precede the first significant word.) 

Subfields used: 
$a uniform title 
 
Examples: 
 
130 0 $a Policy research working papers 
 
 
TRACINGS AND REFERENCES 
 
A cross reference leads from one heading to another  heading. 
 
Tracing fields lead directly from one heading to a single other heading. 
A 4XX See From-Tracing field leads from an  unauthorized heading to an authorized 
heading. 
A 5XX See Also From Tracing field leads from one authorized heading to another 
authorized heading. 
 
Tracing subfields used: 
$w control subfield, character positions: 
 
$a earlier heading 
$b later heading 
 
 
400 SEE FROM TRACING – PERSONAL NAME 
 
Indicators and subfields, see Heading-Personal Name and Tracings subfields. 
 
 
410  SEE FROM TRACING – CORPORATE NAME 
 
Indicators and subfields, see Heading Corporate Name and Tracings subfields. 
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 -  Authority records - 

411  SEE FROM TRACING – MEETING NAME 
 
Indicators and subfields, see Heading Meeting Name and Tracings subfields. 
 
 
430  SEE FROM TRACING – UNIFORM TITLE 
 
Indicators and subfields, see Heading Uniform Title and Tracings subfields. 
 
 
500 SEE ALSO FROM TRACING – PERSONAL NAME 
 
Indicators and subfields, see Heading Personal Name and Tracings subfields. 
 
 
510  SEE ALSO FROM TRACING – CORPORATE NAME 
 
Indicators and subfields, see Heading Corporate Name and Tracings subfields. 
 
 
511  SEE ALSO FROM TRACING – MEETING NAME 
 
Indicators and subfields, see Heading Meeting Name and Tracings subfields. 
 
 
530  SEE ALSO FROM TRACING – UNIFORM TITLE 
 
Indicators and subfields, see Heading Uniform Title and Tracings subfields. 
 
 
670 SOURCE DATA FOUND 
 
Each source citation is contained in a separate F700 field. 
 
indicators: none 
 
Subfields used: 

$a source citation 
$b information found 

 
Example: 
 
110 2  $a World Bank 
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670     $a Its Annual Report, 1981 : $b p. 3 (The World Bank is a group of three institutitons, 
the International Bank for Reconstruction and Development (IBRD), the International 
Development Association (IDA), and the International Finance Corporation (IFC)) 



 

 
 
 
 

EXAMPLES 
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 - Examples - 
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 - Examples - 

MONOGRAPH-1st EXAMPLE 
 
 

A load too heavy : children in mining and quarrying / International Labour...  
 

008 050621s2005 sz a i000 0 eng d  
040__ |a ILO |c ILO 
072_7 |a |2 ilot 
099_9 |a 105B09/123 e,f,s 
24512 |a A load too heavy : |b children in mining and quarrying / |c International Labour Office 

= Un fardeau trop lourd : les enfants qui travaillent dans les mines et l'extraction minière / 
Bureau international du Travail = Una carga demasiado pesada : niños que trabajan en minas 
y canteras / Oficina internacional del Trabajo. 

24611 |a Fardeau trop lourd : les enfants qui travaillent dans les mines et l'extraction minière. 
24611 |a Carga demasiado pesada : niños que trabajan en minas y canteras. 
260__ |a Geneva : |b ILO, |c [2005]. 
300__ |a 1 brochure 
5208_ |a Abstract 
65017 |a |2 ilot 
65027 |a |2 ilot 
655_7 |a ILO pub |2 ilot 
7102_ |a  International Labour Office. 
7750_ |e ita |w 377204 
920__ |a Status |d Date 
925__ |a Indexer 
946__ |a aa |d 2005-06-21 
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 - Examples - 

MONOGRAPH-2nd EXAMPLE 
 
 
The same document in English, French and Spanish. 
 

Women's employment : global trends and ILO responses : ILO contribution,...  
 

008 050622s2005 sz d b i000 0 eng d  
020__ |a 9221174441 
040__ |a ILO |c ILO 
072_7 |a |2 ilot 
099_9 |a 105B09/140 engl 
24510 |a Women's employment : |b global trends and ILO responses : ILO contribution, 49th 

Session of the Commission on the Status of Women, United Nations, New York, 28 
February-11 March / |c International Labour Office, Bureau for Gender Equality. 

260__ |a Geneva : |b ILO, |c 2005. 
300__ |a v, 17 p. : |b statistics 
504__ |a References. 
5050_ |a 1. Introduction -- 2. Overview of labour force participation: Globalisation and the labour

force, Changing nature of the labour force, Gender gap persists, Characteristics of female 
work, Women and care work -- 3. Global employment trends, gender differentials: 
Unemployment trends, employment by status, Employment by sector, Wages and earnings, 
Breaking throu gh the glass ceiling, Employment in the informal economy, Women migrant 
workers -- 4. The ILO commitment to gender equality: ILO action, International Labour 
Standards (Conventions), Countering the decent work deficit, A tripartite commitment to the 
eradication of poverty. 

5208_ |a Abstract 
65017 |a |2 ilot 
65027 |a |2 ilot 
655_7 |a ILO pub |2 ilot 
7102_ |a International Labour Office. |b Bureau for Gender Equality. 
7102_ |a United Nations Commission on the Status of Women |n (49th session : |d 2005 : |c New 

York, United States) 
7750_ |e fre |w 377265 
7750_ |e spa |w 377286 
920__ |a Status |d Date 
925__ |a Indexer 
946__ |a aa |d 2005-06-22 
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 - Examples - 

L'emploi des femmes : tendances mondiales et réponses de l'OIT :...  
 

008 050622s2005 sz d b i000 0 fre d  
020__ |a 9222174445 
040__ |a ILO |c ILO 
099_9 |a 105B09/140 engl 
24512 |a L'emploi des femmes : |b tendances mondiales et réponses de l'OIT : contribution de 

l'OIT à la 49ème Session de la Commission sur le statut de la femme, Nations Unies, New 
York, 28 février-11 mars 2005 / |c Bureau international du Travail, Bureau pour l'égalité entre 
hommes et femmes. 

260__ |a Genève : |b BIT, |c 2005. 
300__ |a v, 25 p. : |b statistiques 
504__ |a References. 
5050_ |a 1. Introduction -- 2. Vue d'ensemble du taux d'activité: Mondialisation et main-d'oevre, 

Evolution de la nature de la main-d'oevre, Persistance de l'écart entre les sexes, 
Caractéristiques du travail féminin, Les femmes et les activités de soins -- 3. Les tendances de 
l'emploi dans le monde, les disparités fondées sur le sexe: Les tendances du chômage, 
L'emploi selon le statut, L'emploi par secteur, Salaires et gains, Briser le plafond de verre, 
L'emploi dans l'économie informelle, Les travailleuses migrantes -- 4. L'engagement de l'OIT 
pour légalité entre les sexes: L'action de l'OIT, Les normes internationales du travail 
(conventions), S'attaquer au déficit en matière de travail décent, Un engagement tripartite 
pour l'éradication de la pauvreté. 

655_7 |a ILO pub |2 ilot 
7102_ |a International Labour Office. |b Bureau for Gender Equality. 
7102_ |a United Nations Commission on the Status of Women |n (49th session : |d 2005 : |c New 

York, United States) 
7750_ |e eng |w 377257 
7750_ |e spa |w 377286 
920__ |a copy |d 2005-06-22 
923__ |a 377257 
946__ |a aa |d 2005-06-22 
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 - Examples - 

El empleo femenino : tendencias mundiales y acciones de la OIT : ponencia... 
 
 

008 050624s2005 sz b i000 0 spa d  
020__ |a 9223174449 
040__ |a ILO |c ILO 
099_9 |a 105B09/140 span 
24513 |a El empleo femenino : |b tendencias mundiales y acciones de la OIT : ponencia de la 

OIT, 49a. sesión de la Comisión sobre la Condición de la Mujer, Naciones Unidas, Nueva 
York, 28 de febrero-11 de marzo de 2005 / |c Oficina para la Igualdad de Género, Oficina 
Internacional del Trabajo. 

260__ |a Ginebra : |b OIT, |c 2005. 
300__ |a v, 23 p. : |b estadísticas 
504__ |a References. 
5050_ |a 1. Introducción -- 2. Aspectos generales del mercado de trabajo: Globalización y 

empleo, Mutaciones en la población activa, Persistencia de la brecha entre hombres y 
mujeres, Caracterísiticas del empleo femenino, Las mujeres y el trabajo asistencial -- 3. 
Tendencias mundiales del empleo, las diferencias entre los sexos: Evolución del desempleo, 
El empleo, clasificado según su situación, El empleo por sector, Salarios y remuneraciones, 
Romper el techo de cristal, El empleo en la economía informal, Las trabajadoras migrantes -- 
4. El compromiso de la OIT con la igualdad de género: La acción de la OIT, Las normas 
internacionales del trabajo (convenios), Remediar el déficit de trabajo decente, Un 
compromiso tripartito hacia la eliminación de la pobreza. 

7102_ |a International Labour Office. 
 7102_ |a International Labour Office. |b Bureau for Gender Equality. 
7102_ |a United Nations Commission on the Status of Women |n (49th session : |d 2005 : |c New 

York, United States) 
7750_ |e eng |w 377257 
7750_ |e fre  |w 377265 
920__ |a copy |d 2005-06-22 
923__ |a 377257 
946__ |a aa |d 2005-06-24 
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 - Examples - 

ANALYTICS 
 

 
First global analysis : HIV/AIDS to have major impact on world of work.  

 
008 050610s2004 sz b i000 0 eng d  
035__ |a 377008 
040__ |a ILO |c ILO 
072_7 |a 15.04.2 |2 ilot 
099_9 |a 09521(2004-52)13-16 
 24510 |a First global analysis : |b HIV/AIDS to have major impact on world of work. 
300__ |a p. 13-16 
504__ |a References. 
5208_ |a Comments on an ILO report entitled "HIV/AIDS and work : global estimates, impact 

and response" (ILO, 2004). 
65017 |a HIV/AIDS |2 ilot 
65017 |a labour force |2 ilot 
65017 |a economic implication |2 ilot 
65017 |a social implication |2 ilot 
65017 |a developed countries |2 ilot 
65017 |a developing countries |2 ilot 
655_7 |a ILO pub |2 ilot 
7730_ |t World of work : the magazine of the ILO. |d Geneva : ILO. |g No. 52 (Nov. 2004) |x 

1020-0010 
85641 |3 Full text |u http://www.ilo.org/public/english/bureau/inf/magazine/52/hivaids.htm  
920__ |a biblio |d 2005-06-24 
925__ |a aa 
946__ |a aa |d 2005-06-10 
 

 123

 



 - Examples - 

Specifications for analytics cataloguing: “Special topic” 
 
 

- Use “special topic”, “thème spécial”, “tema especial” 
 
- Pay attention to the “comme un tout”: add the contents (titles and authors) in a “Contents 
note”. 
 
See examples: 
 
 Example 1: cataloguing of a special issue as a whole. 
 
 Example 2: cataloguing of an article in a special issue. 
 

 124

  



 - Examples - 

 
Example 1: cataloguing of a special issue as a whole.  Used for cataloguing a special issue 
of a journal which is published with a collective title.  The individual articles are not 
catalogued separately: 
  
245 10 Title of the special issue [special topic]. 
505 0   Title / author(s) -- Title / author(s).  
(Do not enter 700 fields for the authors mentioned in 505). 
 

Parental leave, early maternal employment and child outcomes  
 

008 050420s2005 xxkd b 0 eng d  
 040__ |a ILO |c ILO 
072_7 |a |2 ilot 
099_9 |a 40203(2005-501)1-80 
24510 |a Parental leave, early maternal employment and child outcomes [special topic]. 
300__ |a p. 1-80 : |b statistics 
504__ |a References. 
5050_ |a Symposium on parental leave,  early maternal employment and child outcomes: 

introduction / Paul Gregg and Jane Waldfogel ---Parental leave and child health across OECD 
countries / Sakiko Tanaka -- Maternity leave, early maternal employment and child health 
and development in the US / Lawrence M. Berger, Jennifer Hill and Jane Waldfogel -- The 
effects of a mother's return to work decision on child development in the UK / Paul 
Gregg...[et al.]. 

5208_ |a Abstract 
65017 |a |2 ilot 
65027 |a |2 ilot 
655_7 |a |2 ilot 
7730_ |t The economic journal : the journal of the Royal Economic Society. |d Oxford : 

Blackwell Publishers. |g Vol. 115, no. 501 (Feb. 2005) |x 0013-0133 
85641 |3 Full text/table of contents on Ebsco |z Access limited to ILO Geneva-based staff |u 

http://www.ilo.org/intracgi/oneclick.pl?Epub=100833 
920__ |a Status |d Date 
925__ |a aa 
946__ |a aa |d 2005-04-20 
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 - Examples - 

Example 2: cataloguing of an article in a special issue: 
 
245 10 Title of the article. $p [Special topic :] Title of the special issue.  
   

Globalization, production, employment and poverty : debates and evidence....  
 

008 040331s2004 d b 0 eng d  
035__ |a 367078 
040__ |a ILO |c ILO 
072_7 |a 03.03.6 |2 ilot 
0410_ |a eng b eng 
 099_9 |a 354628 
1001_ |a Jenkins, Rhys. 
24510 |a Globalization, production, employment and poverty : |b debates and evidence. |p 

[Special topic :] Globalization, production, employment and poverty / |c Rhys Jenkins. 
300__ |a p. 1-12 : |b ill. 
504__ |a References. 
5208_ |a Reviews studies concerning the impact of economic globalization on poverty and 

employment in developing countries. 
65017 |a |2 ilot 
65027 |a |2 ilot 
655_7 |a |2 ilot 
7730_ |t Journal of international development. |d Chichester : Wiley. |g Vol. 16, no. 1 (Jan. 

2004) |x 0954-1748 
85641 |3 Full text on Ebsco |z Access limited to ILO Geneva-based staff |u 

http://www.ilo.org/intracgi/oneclick.pl?Epub=102369 
920__ |a Status |d Date 
925__ |a aa 
946__ |a aa |d 2004-03-31 
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 - Examples - 

SERIAL 
 
 

Global employment trends for youth / International Labour Office.  
 

008 040819 2004 sz ar s i0 eng d  
035__ |a 370193 
040__ |a ILO |c ILO 
041__ |a eng 
072_7 |a 13.01.3 |2 ilot 
099_9 |a P09316 
24510 |a Global employment trends for youth / |c  International Labour Office. 
260__ |a Geneva : |b ILO, |c 2004- 
300__ |a v. : |b statistics 
310__ |a Annual 
3620_ |a (2004)- 
65017 |a youth employment |2 ilot 
65017 |a youth unemployment |2 ilot 
65017 |a developed country |2 ilot 
65017 |a developing country |2 ilot 
655_7 |a ILO pub |2 ilot 
7102_ |a International Labour Office. 
7750_ |e fre |w 370200 
7750_ |e spa |w 370204 
85641 |3 Full text |u http://www.ilo.org/public/english/employment/strat/global.htm 
920__ |a biblio |d 2005-04-29 
925__ |a aa 
946__ |a aa |d 2005-01-14 
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 - Examples - 

VIDEORECORDING 
 
 

Rising from the ashes ILO/IFP-Crisis.  
 

008 030617s2003 sz 022 i vleng d  
035__ |a 361220 
040__ |a ILO |c ILO 
072_7 |a 13.01.3 |2 ilot 
099_9 |a 103V1 engl 
24510 |a Rising from the ashes |h [videocassette] / |c ILO/IFP-Crisis. 
260__ |a Geneva : |b ILO, |c 2003. 
300__ |a 1 videocassette (PAL) (22 min.) : |b sd., col. 
5208_ |a From natural disasters in India or El Salvador, to the war in Croatia, to the economic 

collapse of Argentina, this film shows how the "InFocus Programme on Crisis Response and 
Recostruction" succeeds in restoring the dignity of survivors by creating a new life for them 
with decent work. 

65017 |a  promotion of employment |2 ilot 
65017 |a livelihoods |2 ilot 
65017 |a  economic reconstruction |2 ilot 
65017 |a role of ILO |2 ilot 
65017 |a natural disaster |2 ilot 
65017 |a civil war |2 ilot 
65017 |a economic recession |2 ilot 
65017 |a Argentina |2 ilot 
65017 |a Croatia |2 ilot 
65017 |a El Salvador |2 ilot 
65017 |a India |2 ilot 
655_7 |a ILO pub |2 ilot 
7102_ |a ILO InFocus Programme on Crisis Response and Reconstruction. 
7102_ |a International Labour Office. 
7750_  |e fre |w 361235 
7750_ |e spa |w 361236 
85641 |3  Abstract |u http://www.ilo.org/public/english/support/publ/xtextem.htm#b240x 
920__ |a biblio |d 2003-06-17 
925__ |a aa 
946__ |a aa |d 2003-06-17 

 128

 



 - Examples - 

CD-ROM 
 
 

MATCOM Cooperative management training = Formación en gestión de...  
 

007 co cv--------- 
008030221s2002 sz u i eng d  
035__ |a (OCoLC)ocm51718516 
035__ |a 358290 
040__ |a IL# |c IL# 
0410_ |a engfrespapor 
072_7 |a |2 ilot 
099_9 |a 102B09/370 E,F,S 
24510 |a MATCOM |h [CD ROM] : |b Cooperative management training = Formación en 

gestión de cooperativas = Formation en gestion de coopératives = Formação en gestão de 
cooperativas / |c Cooperative Branch, International Labour Office. 

24610 |a Cooperative management training 
24611 |a Formación en gestión de cooperativas 
24611 |a Formation en gestion de coopératives 
24611 |a Formação en gestão de cooperativas 
260__ |a [Geneva] : |b ILO, |c [2002]. 
300__ |a 1 computer laser optical disc 
538__ |a Requirements : Windows XX or NT and 32 MB RAM, Pentium I processor, Monitor 

resolution 800x600 pixels. 
546__ |a Text in English, French, Spanish and Portuguese. 
65017 |a  |2 ilot 
65027 |a |2 toit 
7102_ |a International Labour Office. |b Cooperative Branch. 
920__ |a Status |d Date 
925__ |a Indexer 
946__ |a xx |d 2003-02-21 
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 - Examples - 

WWW DOCUMENT-MONOGRAPH 
 
 

Changing patterns in the world of work consultation draft / ILO. 
 

008 050620s2005 sz sb i0 eng d  
 040__ |a ILO |c ILO 
072_7 |a 13.01.1 |2 ilot 
099_9 |a WWW ACCESS ONLY 
24510 |a Changing patterns in the world of work |h [electronic resource] : |b consultation draft / 

|c ILO. 
260__ |a [Geneva : |b ILO, |c 2005]. 
300__ |a 81 p. 
500__ |a Mode of access : World Wide Web (available in electronic format only). 
500__ |a Description based on the Internet version on the World Wide Web. 
504__ |a References. 
5050_ |a Chapter 1. Changing patterns in the world of work -- Chapter 2. The transformation of 

world employment -- Chapter 3. Convergence or divergence in conditions of work 
worldwide? -- Chapter 4. Trends and issues in the governance of the world of work. 

5208_ |a Analyses the emerging contours of a global labour market and looks at what this means 
for working women and men and their families. Discusses how labour law, government 
services, employers' organizations, unions, collective bargaining and tripartism are 
responding to globalization. 

65017 |a work |2 ilot 
65017 |a future of work |2 ilot 
65017 |a employment |2 ilot 
65017 |a working conditions |2 ilot 
65017 |a labour relations |2 ilot 
65017 |a developed countries |2 ilot 
65017 |a developing countries |2 ilot 
65027 |a preliminary report |2 ilot 
65027 |a draft |2 ilot 
65027 |a decent work |2 ilot 
65027 |a informal employment |2 ilot 
65027 |a workers rights |2 ilot 
65027 |a tripartism |2 ilot 
65027 |a social dialogue |2 ilot 
65027 |a labour law |2 ilot 
65027 |a law reform |2 ilot 
655_7 |a ILO pub |2 ilot 
7102_ |a International Labour Office. 
7750_ |e fre |w 377182 
7750_ |e spa |w 377183 
85640 |3 Full text |u http://www.ilo.org/intranet/english/bureau/dgo/patterns/depts_2005_en.pdf 
920__ |a btran |d 2005-06-20 
925__ |a aa 
946__ |a aa |d 2005-06-20 
 
NOTE : If we receive the physical copy of the document, some changes will be necessary: 
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- Replace the callno WWW ACCESS ONLY by the new callno 
- Delete : “$h [electronic resource]”, 
- Delete gnote : “Mode of access...” 
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- Add other changes as applicable. 
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WWW DOCUMENT-SERIAL 
 
 

ILO Subregional Office for Central and Eastern Europe Virtual Newsletter  
 

008
030923c2003 hu | pss eng d  

035__ |a 362909 
040__ |a ILO |c ILO 
072_7 |a |2 ilot 
099_9 |a WWW ACCESS ONLY 
24510 |a ILO Subregional Office for Central and Eastern Europe Virtual Newsletter |h 

[electronic resource]. 
260__ |a Budapest : |b ILO, |c 2003- 
3620_ |a No. 1 (2003)- 
500__ |a Mode of access : World Wide Web (available in electronic format only). 
500__ |a Description based on the Internet version on the World Wide Web. 
650
655

17 |a |2 ilot 
  7 |a ILO pub |2 ilot  

7102_ |a ILO Subregional Office for Central and Eastern Europe. 
85640 |3 Full text |u http://www.ilo-ceet.hu/index.htm 
920__ |a Status |d Date 
925__ |a Indexer 
946__ |a aa |d 2003-09-23 
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EXAMPLE CIP (CATALOGUING IN PUBLICATION DATA) 
 
ILO documents can appear in Labordoc before publication. 
 
The draft document is sent to the unit in charge of  cataloguing (INFORM in the case of 
Geneva) and a record is created in Labordoc with some specific information: 
 
- NYP as callno in field 099 (=Not Yet Published) 
- A note in field 500: “Description based on the manuscript for publication” 
- Status “atran” in field 920a 
 
The cataloguing data is transcribed in a sheet and will be introduced in the document with the 
mention “ILO cataloguing in publication data”. 
 
Once the document published and received in the Library or Documentation Center some 
changes will be necessary: 
 
- Replace  the callno NYP   with the new callno 
- Delete  the note: “Description based…” 
- Add other changes as applicable (for example check the number of pages in field 300) 
- Replace the status atran with btran and change the status date. 
 
 

Vocational education and training institution : a management handbook and...  
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008 050304s2005 sz b i000 0 eng d  
020__ |a 9221171043 
040__ |a ILO |c ILO 
072_7 |a 06.02 |2 ilot 
099_9 |a NYP 
24510 |a Vocational education and training institution : |b a management handbook and CDROM 

/ |c designed and edited by Vladimir Gasskov ; principle contributors Peter Noonan, Anne 
Deschepper, George Preddey, Beryl Pratley ; International Labour Office. 

260__ |a Geneva : |b ILO, |c 2005. 
300__ |a 1 v. + |e 1 computer laser optical disc 
500__ |a Description based on the manuscript for publication. 
5208_ |a  Abstract. 
65017 |a |2 ilot 
65027 |a  |2 ilot 
655_7 |a  |2 ilot 
7001_ |a Gasskov, Vladimir. 
7001_ |a Noonan, Peter. 
7001_ |a Deschepper, Anne. 
7001_ |a Preddey, George. 
7001_ |a Pratley, Beryl. 
7102_ |a International Labour Office. 
920__ |a atran |d Date 
925__ |a Indexer 
946__ |a aa |d 2005-03-04 
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Cataloguing Help Sheets 
 
FIXED FIELDS 
 
Publication Status  s   
 
Date 1    200X 
 
Place of Publication  Select the country of publication from the grid 
 
Illustration 1 
 _ no illustrations 
 a for illustrations in general 
 d for statistics: graphs, tables, etc. 
 
Form of Item 
 _ none of the following (by default) 
 s for electronic documents (e-doc, e-ser)  
 
Contents 1 
 _ no specified nature of contents 
 b if the document contains bibliographic references 
 
Govt. Publication 
 _ not a government publication 
 i for international or intergovernmental organisations documents 
 f for federal or national institutions documents 
 
Language  Select the language of the document from the grid 
 
Cataloguing source always select d 
 
Special fields to enter for serials 
  
Frequency  Select the frequency of the serial from the grid 
 
Regularity  Select the regularity of the serial from the grid 
 
Type of Serial p periodical 
 
Special fields to enter for videocassettes 
 
Type of material 
 v videorecording 
 z other type of material (DVD) 
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VARIABLE FIELDS: Monographs 
 
020  ISBN  [without -] 
 
040  ILO $c ILO  [entered automatically] 
 
041  engfreger [only if more than one language] 
 
088  Report number 
 
099  9 97B09/   engl 
 
100 1 Surname, Name.  [1st author, authority] 
 
245      1? Title : $b subtitle / $c authors. [elements entered exactly as they appear on the title 

page] 
 
260  Place : $b publisher, $c date. 
 
300  245 p. : $b statistics 

2 v. 
 
440  0 Collection, $x ISSN ; $v No. xx 
or 
490       ?          Collection, $x ISSN ; $v No. xx 
 
500  General note. 
 
504  References. 
 
505    0 Chapter 1. Title / Author(s) – Chapter 2. Title. 
 
700 1 Surname, Name. [2d author, authority] 
 
710 ? Corporate name. [corporate name authority] 
 
711    2 Conference $n (No. : $d date : $c place, country) [conference authority] 
 
775    0  $e Language xxx $w bib id 
  
830      ? Collection ; $v No. xx [add if 490 is present and a traced authority form exists for the 

series] 
 
856    41          $3 Full text $u http… 
 
946  ab 
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VARIABLE FIELDS: Analytics 
 
040  ILO $c ILO  [entered automatically] 
 
041  engfreger [only if more than one language] 
 
049  IL#O  
 
099  9 XXXXX(20XX-X)pp-pp 
 
100 1 Surname, Name.  [1st author, authority] 
 
245 1? Title of article : $b subtitle / $c authors. [elements entered exactly as 

they appear on the title page] 
 
300  p. xxx-xxx : $b ill., statistics 
 
500  General note. 
 
504  References. 
 
505    0 Chapter 1. Title / Author(s) – Chapter 2. Title. 
 
700 1 Surname, Name. [2d author, authority] 
 
710  ? Corporate name. [corporate name authority] 
 
773   0 $t Name of periodical. $d place : publisher. $g Vol., no., (xxx 199x)  $x ISSN 
 
775    0  $e Language xxx $w bib id 
 
856    41          $3 Full text $u http… 
 
946  ab 
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VARIABLE FIELDS: Serials 
 
022  ISSN 
 
040  ILO $c ILO  [entered automatically] 
 
041  engfreger [only if more than one language] 
 
099  9 PXXXX 
 
245    1? Title : $b subtitle / $c authors. [elements entered exactly as they appear on the 

title page] 
 
260  Place : $b publisher, $c date-    
 
300  v. 
 
310  Monthly   
 
362 0     No. 1 (1995) - 
 
500  General note.  
 
504  References. 
 
710 ? Corporate name. 
 
775 0 $e Language xxx $w bib id 
 
780 00 $t Preceding title. 
 
785 00 $t Succeding title. 
 
856    41          $3 Full text $u http…  
 
946  aa 
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 - Annexes - 

Annex 1 : Cataloguing Toolbar 
 
 

 

This button is used to create a new record from a template. If a path is set for 
bibliographic records in Folders/Files in the Preferences, clicking New, by going to 
the Record menu and selecting New followed by Bibliographic, or typing ALT-R + N 
+ B leads directly to the bibliographic record template.  If not, you can find it by 
double-clicking Catalog in the Open dialog box, and then Templates. You can also 
use ALT-R + N + A to use the authority record template in the same manner. 

An alternative method is available through the down arrow beside the New button. 
Clicking on this arrow gives a choice of Authority or Bibliographic. Selecting from 
these choices works in the same manner and selecting the choice from the Record 
menu. 

 

The Open and Save buttons are used for saving record(s) to a file on your computer, 
without saving it to the database, and then opening the file again. The use of these 
buttons also requires some setup in the Folders/Files section of the Preferences. It is 
unlikely we will use these features. 

 

The setup requres creating a Work directory on your computer, and assigning the path 
in the box labelled Folders Work and in all three boxes under Work Files. Once that is 
done, the first time you save any record to Work you must go the the File menu, select 
Save As, and give the file a name. After that, you can save further changes simply by 
clicking on Save. Bibliographic and Holdings Records must be saved separately, and 
Item records cannot be saved. 

 

To perform a search, click on the Search button, or type ALT-R + S. 

 

 

You can return to the Browse search result by clicking on the Headings List button. 
You can also type in ALT-D + H. 

 

At any point in your session, you may return to your previous search result window by 
clicking on the Titles button, or by typing ALT-D + T. You may also go to the Display 
menu, and select Title index.. 

 

Clicking on the sailboat (or typing CTRL-B) saves the information to the database. 
(Typing CTRL-Z saves and closes the record). It is most important to save before you 
close any record you have worked on, or you will lose your work. (Sometimes the 
system will warn you that a record has been changed if you try to close it; sometimes it 
may not. 
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The Save Plus button will save the current record to the database and to your work file 
on your computer. This button only appears on the toolbar if you have filled in the 
Save to Local File box in the Folders/Files tab in your Preferences. 
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Clicking on this icon brings up the Holdings Template (if you have the path set in 
Folders/Files in Preferences), with an 852 field that reflects your default settings in 
the General tab of your Preferences. 

You may also select Create Holdings from the Record menu, or type ALT-R + E. 

 

The Get Holdings button will bring up an existing Holdings record, or a list of Holdings 
record, if there is more than one. 

You may also select Retrieve Holdings from the Record menu, or type ALT-R + H 

 

This icon brings up an Item screen. If you select this while displaying a bibliographic 
record, Voyager first asks you Link item to existing Holding? If you say Yes it gives 
a list of holdings records from which to choose. 

You may also select Create Items from the Record menu, or type ALT-R + T 

 

The Get Items button will bring up an existing Item record, a list of Holdings records 
linked to the bibliographic record, if there is more than one, or a list of item records 
attached to the holdings record. 

You may also select Retrieve Items from the Record menu, or type ALT-R + M 

 

This button brings up a dialog box showing the bibliographic record ID and each 
MFHD ("muffhead", i.e. MARC Format Holdings Data) ID. Clicking on the + sign in 
front of a MFHD ID brings up a list of item IDs. 

With bibliographic, holdings and item records all up, you can use the Cascade or Tile 
command from the Windows menu to view these records all at once. Note that the 
record numbers are all different, and that the Holdings record refers to the 
bibliographic record number, and the item of its holding, but the bibliographic and 
item records do not contain such references.  

You may also select Show Associated Records from the Record menu, or type ALT-R 
+ W 

 

The Help icon brings up the general Voyager help file, with Contents, Index and Find 
tabs. You can also get Help at any point by pressing the F1 key; this Help will be 
relevant to where you are in the program. 
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Annex 2: Articles in different languages 
considered as nonfiling characters 

 (field 245, etc.) 
 

Arabic (article added as suffix) 
Bulgarian none 
Czech  none 
Danish  Den, Det, De, En, Et 
Dutch  De, Een, Eene, Het, ‘n, ‘t 
English A, An, The 
French  L’, La, Le, Les, Un, Une, Des (unless it is the contraction of “de les”) 
German Der, Die, Das, Ein, Eine 
Greek  E, O, To 
Hebrew ha-, he- (when joined to initial word of title)  
Hungarian A, Az 
Icelandic Hin, Hinn, Hio, Hinir, Hinar (no indefinate article) 
Italian  I, Il, L’, La, Le, Lo, Gli, Un, Una, Uno, Un’ 
Japanese none 
Norwegian Den, Det, De, Dei, En Ein, Ei, Et, Eit 
Polish  none 
Portuguese A (if it is an article), As, O, Os, Um, Uma 
Rumanian (definite article added as a suffix) Un, Una, O 
Russian none 
Slova k none 
Spanish El (except in case of El Salvador), La, Las, Los, Un, Una, Unos, Unas 
Swedish Den, Det, De, En, Ett 
Turkish (no definite article) Bir 
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Annex 3: Transliteration Sheet 
     
Please : 
1. Fill in the requested data appearing in the publication. 
2. Transcribe in Latin characters reproducing exactly the source of information. 
3. When possible, translate into English the transcribed data. 
 
TITLE and subtitles : 
 
 
 
 
AUTHORS, name surname(s) : 
1. 
 
2. 
 
3. 
 
4. 
 
EDITION (second, third, ...) : 
 
PUBLICATION : 
Place of publication : 
Publisher : 
Date of publication : 
 
 
PAGES : 
 
SERIES, COLLECTION AND VOLUME OR NUMBER IN THE SERIES : 
 
 
Are there any BIBLIOGRAPHICAL REFERENCES? (yes or not) : 
 
NAMES OF ORGANISATIONS and function in the publication, and NAMES OF MEETINGS, 
CONFERENCES, etc.  : 
1. 
 
 
2. 
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Annex 4: New system of call numbers for scanned 
documents 

 
(in use since 4 May 2004). 
 
Fill in, for each scanned article: 
the call number of the periodical (do not include “P”): e.g. 41438; 
the publication year of the periodical followed by the issue number, in brackets. If there is no 
issue number, the month or season should be indicated, e.g. (2004-6), (2004-June), (2004-Fall); 
the first and last page numbers of the article: e.g. 34-79.  For articles catalogued under a 
collective title, only indicate the number of pages:  only: e.g. 239 
Example of full call number: 41438(2004-6)34-79 
 
If the periodical is a double issue or covers several months, it should be indicated as follows: 
09602(2004-2-3)24-89 or 40023(2004-Jun-Dec)80-198. 
 
NB: you should only indicate the month or the season if there is no issue number for the 
periodical. 
 
The call number will be included as the file number in the server and will appear as follows: 
09628(2004-3)28-50.pdf 
 
It is important that each call number be completed accurately so that the article can be located in 
the database of the server. 
 
The scanned articles will be stocked in the C drive. The files will be copied on to a server for 
internal web access only:  only ILO staff and interns will have access to these files. 
 
All scanned articles should be printed at the end of each day.  To print, each file should be 
highlighted and the article printed. For articles catalogued under a collective title, only the first 
page is printed (provided it includes all the necessary information, i.e. date, issue no. The call 
number of each article should be clearly indicated on the photocopy, so that cataloguer can enter 
this code correctly in Labordoc. 
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Annex 5: Voyager client software installation 
instructions 

 

1 Introduction 
 
You are being given access to the Voyager system as part of the ILO library. This enclosed CD-
ROM and instructions are, and remain the property of the International Labour Office. The 
programs on this CD-ROM are protected by international copyright. 
 
By accepting this CD-ROM, you agree to keep the information contained on the CD-ROM and 
these instructions confidential and, at the end of your contract, to (a) return the CD-ROM and 
this documentation to the ILO and (b) to remove from all computers and computer media any 
and all of these programs and associated files. 
 
2 Requirements 
 
For the current requirements for using Voyager, please see the document entitled External 
Access to Voyager. 
 
3 Installation of the Voyager client 
 
1. Insert the CD-ROM in the CD-ROM drive of your computer. 
 
2. Open Windows Explorer and navigate to your CD-ROM drive. 
 
3.  There are three executable files on the CD-ROM in \Voyager 2001 Clients\ 
 

VoyagerConfig.exe 
VoyagerPrograms.exe 
VoyagerSystem.exe 

 
The files must be executed in this order 
 
4. From Windows Explorer, double click on the VoyagerConfig.exe file. 
 
5. At the Welcome to Voyager Programs window, click the Next button 
 
6. At the Select Destination Directory window, click Next to accept the default directory 

(c:\voyager). 
 
7. At the Ready to Install window, click the Next button. 
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8. At the Installation Completed window, click Finish. 
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9. From Windows Explorer, double click the VoyagerPrograms.exe file. 
 
10. At the Welcome to Voyager Programs window, click the Next button 
 
11. At the Select Destination Directory, click Next to accept the default c:\voyager directory. 
 
12. If the message “That directory already exists, would you like to install anyway?” displays, 

click Yes. 
 
13. Click the Next button. 
 
14. At the Select Components window, check that the box for Cataloging is checked (this is the 

only module you would need to start with). Ensure that all other boxes are unchecked.  
 
15. Click the Next button. 
 
16.  At the Ready to Install window, click the Next button 
 
17. At the Installation Completed window, click the Finish button. 
 
18. From the Windows Explorer window, double click the VoyagerSystem.exe file 
 
19. At the Welcome to Voyager Programs window, click the Next button. 
 
20. At the Ready to Install window, click the Next button. 
 
21. At the Installation Completed window, click the Finish button. 
 
4 Configuration of the Voyager clients 
 
Before you can begin to use the Voyager cataloguing client, you must configure the software. 
We have provided a set of already completed configuration files. You need to copy these 
configuration files onto your c:\Voyager directory. 
 
 
 
1. From Windows Explorer, highlight voyager.ini in  \Voyager 2001 Clients\ on the CD-

ROM. (Note: Depending on the options you have specified for Windows, you may not see 
the extension of this file displayed:) 

 
voyager.ini 

 
2. Copy the file to the c:\Voyager directory. When prompted to replace the existing 

voyager.ini file with the new one, click Yes. 
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3.  In Windows Explorer, click once on the voyager.ini file in the c:\Voyager directory to 
highlight the file name. Right click the mouse button to display a popup menu. From the 
menu, select Properties. At the Properties window, unselect the Read-only and Archive 
boxes if checked. 

 
4. Copy \Catalog folder on the CD-ROM to c:\Voyager. When prompted to replace the 

existing folder with the new one, click Yes to All. 
 
5 Manual configuration of the Voyager clients 
 
At some point in the future the address of the server on which Voyager runs may change. You 
will be informed when the change will take place and what changes it will be necessary to make. 
Make the changes following these procedures. 
 
1. Using WordPad, open the file voyager.ini in the c:\voyager directory. 
 
2. Make the changes as indicated by ILO HQ Library staff. 
 
3. Save the voyager.ini file and exit Wordpad.  
 
6 Testing 
 
To test your installation, connect your PC to the Internet through the connection established by 
your Internet Service Provider (ISP). 
 
1. From the Start Menu, select Programs | Voyager | Cataloging. 
 
2. When you are prompted for your user name and password, you are connected to the 

Voyager server. Enter your user name and password and click OK. 
 
3. You should now set Defaults and Preferences before you start cataloguing and/or indexing 

in Labordoc. 

 

7 Setting defaults and preferences 
 
1. In the Cataloging client, select Option | Preferences from the main menu at the top of the 

window. 
 
2 On the General tab, set the preferences as follows 

Holdings/Item default location:  
Select your library location e.g. ILO-Lima 

Call Number Hierarchies   ILO Call number 
Bibliographic Import/Replace Profile  ILO Cataloguing 
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Authority Import/Replace Profile  ILO Authority Work 
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[[] Delete records from work file...  

[[] Delete records from import file... 

[[] Add a subfield ‘a’ ... 

[[] Display MARC views maximized. 
 
3. Select the Validation tab. On this tab, set the preferences as follows: 

Cataloging formats  Marc21 
[   ] Bypass Authority Control Validation 

[[] Display all the headings 
[   ] Bypass MARC validation 

 [[] List all the errors 
 [   ] Show errors one at a time 
Heading types 

 [[] Name 

 [[] Title 

 [[] Name/Title 

 [[] Subject 

 [[] Subdivision 
Leave the other values  on the Validation tab (URN: , DOI: Image Server.) blank. 

 
4. On the Work Flow tab set the preferences as follows: 

[[] Retain last search 

[[] Automatic truncation for non-keyword searches 

[[] Display bibliographic record diretory if search results in only one title 
[   ] Always create a holding when adding holdings to bib 
[   ] Display item record directly if item retrieve results in only one item 
[   ] Sequence new items at top 

[[] Check for Duplicate Item Barcodes 
 
[   ] Suppress confirmation message upon successful save 

 
5. On the Item Defaults tab, set the preferences as follows: 

Item type:   Book/article 
Status:   In Process 
Stat category:  A 
Copy   1 
Pieces   1 

Leave all other values on the Item Defaults tab blank 
 
6. On the Folders/Files tab, set the following preferences: 

Templates: 
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 Hold c:\voyager\catalog\template\default\hold.tem 
 Auth Blank 
Work Files: Do NOT use […] icon for browsing the folder. TYPE the following. 
 Bib c:\voyager\catalog\voyework 
 Hold c:\voyager\catalog\voyehold 
 Auth c:\voyager\catalog\voyeauth 
Folders 
 Work  c:\voyager\catalog 
 Template: c:\voyager\catalog 
 Import : c: 

Leave all other values blank on the Folders/Files tab 
 
7. On the Mapping tab, set the following preferences: 

Expected Character Set 
 Local import:   OCLC 
 Z39.50 import  MARC21 
MARC mapping for OCR Data 
 Tag:  500 
 Indicator 1 [blank] 
 Indicator 2 [blank] 
 Subfield  a 

 
8. On the Colors/Fonts tab, 

MARC view 
Set  Bibliographic back colour to white (default) 

 Set Holdings back colour to yellow 
 Set Authority back colour to green 
Record hierarchy 
 Set Bibliographic back colour to white (default) 
 Set Holdings back colour to white (default) 
 Set Item back colour to white (default) 
 Set Bound with back colour to white (default) 
 
 
Font 
 Name   Voyager Diacritics 
  
Size   12 
 [   ] Bold 
Global Heading Change Hierarchy 
 Level 1: Old Heading back colour to white (default) 
 Level 2:  New Heading back colour to white (default) 
 Level 3:  Auth Heading back colour to white (default) 
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Annex 6:Windows in Voyager 
 
For the most part, Voyager follows the standard Windows conventions. 

Both the Voyager cataloguing module window, and the individual record windows within the 
module, have the standard controls in the upper right hand corner: 

 

Using these three boxes, you can Minimize (shrink the display), Maximize (enlarge the display 
to fill the screen) or Close the window.  
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